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Chapter 1

Getting Started Guide

Introducing Sage 100

Sage, the recognized leader in accounting software for small- and mid-size
businesses, welcomes you to Sage 100.

About This Guide

The Getting Started Guide is for first-time users and people upgrading from a prior
version of the product. This guide assumes you have a basic understanding of
Microsoft Windows®. Before you begin using the software, read this guide for a
general overview of system features, common procedures, and other important
information.

Some sections of this guide reference Business Insights Reporter and the eBusiness
Manager, Material Requirements Planning, and Work Order modules, which are not
available for Sage 100 Premium.

This guide contains the following information:

e An introduction to the software, including its toolbars, views, windows, and
navigation tips

e How to get help while you work
e Hands-on lessons that demonstrate common system-wide procedures
e Troubleshooting information

Some features described here may not be available in your Sage 100 system.
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About This Guide

Graphic Conventions
The following icons are used throughout this manual to indicate different types of

information.
The NoTe symbol is followed by additional information about

é a topic.

The HeLpruL HINT symbol is located in a grey text box and
followed by additional information about an option.

The WARNING symbol is followed by information to help you

A avoid costly mistakes.
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Where to Find Information

Text Conventions

The following table describes the text conventions used in this manual.

Text Convention Explanation

Menus Menus are shown in this format: Select menu >
menu task name.

Examples:

e Select File menu > Change Company.
e Select General Ledger Budget menu >
Budget Maintenance.

Bold font Indicates text entered at a field or text selected at
a field.

e Examples:

e Atthe Value field, type a search value, such
as 01, for the lookup.

e In the Filter window, to delete a filter, select
<none> at a filter's Column field.

Italic font Indicates references to other manuals.
Example:

e For more information about installing demo
data, refer to your Installation and System
Administrator's Guide.

Where to Find Information

Your Sage 100 system is a powerful, flexible program. The software provides
several resources to help answer your questions. Sources of documentation include
the Help system, the Installation and System Administrator's Guide, the feature
tours, and additional documents. Customer Support is available as well.

Help System

Use the Help system when you want overview information, selective procedures for
day-to-day processing, or detailed information and entry samples for a specific field.
For more information, See Using the Help System on page 41.
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Where to Find Information

Getting Started Guide

Installation and System Administrator's Guide

An Installation and System Administrator's Guide is included in your software
package. This guide provides the information necessary for installing the software,
detailed system requirements, and troubleshooting tips on the configuration of the
various operating systems and environments in which the software is supported. It is
designed to function as a self-teaching guide.

Customer Upgrade Guide

If you are upgrading from a previous version of the software, the Customer Upgrade
Guide is also included in your software package and provides information on the
changes to expect after upgrading to a new version of your Sage 100 system. This
guide lists changes to the software that may affect your daily business processes.
For a complete list of enhancements, see the What's New page accessible from the
Resources page of the Sage 100 Desktop. For more information, see What's New
on page 4.

What's New

From the Desktop's Resources page, click What's New to learn about the latest
software enhancements. Also, on the Resources page, click Getting Started to
access this guide in an online format. For more information, see About the Desktop
Web Pages on page 31.

Additional Documents

Additional documents provided for your benefit include Release Notices, Supported
Platform Matrices, product update information, and file layout and program
information.

Use the Release Notices to learn about enhancements, features, and modifications
for each module of the software release. The Release Notices are installed with your
software. To view them, access the What's New page and click Release Notices.

For a complete list of system requirements, refer to the Supported Platform Matrix.
To access the matrix, see article ID 47649 in the Sage Knowledgebase at
support.na.sage.com.

If a product update is available for your version of the software, from the Desktop
Resources page, click Product Update to view a list of changes included in the
update.

From the Desktop's Resources page, click the File Layouts and Program Information
link to view file layout and program information.

Customer Support

Sage Business Care Support Plans provide you with the technical expertise you
need to keep your accounting system running smoothly. For more information, call
1-866-709-2432 or e-mail us at clientcare.na@sage.com. Customer support is also
available online at: https://support.na.sage.com
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Chapter 2

é NoOTE

Business Insights
Reporter and the
Material
Requirements
Planning and
Work Order
modules are not
available for
Sage 100
Premium.

Getting Started Guide

Touring the Software

This chapter is an introduction to the software, its common buttons and icons,
different views, navigation tips, and common functionality available in maintenance
and data entry windows. The screens in this chapter reflect the ABC company
demonstration data, which can be installed with your software at any time.

Getting to Know Your Desktop

The Desktop provides access to all installed modules and allows you to perform
global functions, such as selecting a company, changing a module's accounting
date, and searching for Help topics. In addition, the Desktop Web pages provide you
with important information and resources. You can customize the Desktop to fit your
needs by selecting different views, adding buttons to the Custom Buttons toolbar,
and creating private tasks. Understanding the functions of the Desktop allows you to
navigate throughout the software.

Selecting a Desktop Version

There are two versions of the Desktop, Standard and Classic. You can select the
version that you prefer on the User Settings window.

To select a Desktop version

1 On the Sage 100 File menu, select Change User Settings.
2 Inthe Desktop field, select either Standard or Classic.
The change will take effect when you restart Sage 100.

The following pages describe the two versions of the Desktop. Most of the
functionality is the same, but there are some features that are exclusive to each
version.

e To learn about the Standard Desktop see page 6.

e To learn about the Classic Desktop see page 15.
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Standard Desktop

Standard Desktop

This section describes the Standard Desktop. For information on the Classic
Desktop, see page 15.

Quick A- @ @& - Sage 100 H - O x
Access Home | Web Content  Modules  Favorites  View  Help ~ =0

Toolbar -
@ m oL L ® 5

i i — Ribbon
Change Change Change Change User Help
Company  Date User Settings v
Modules < | Search all tasks £ | (@ Information Center (<} -]
& Accounts Payable + Explore
& Accounts Receivable
& Bank Reconciliation + Main
& Bill of Materials . 1
= + Period End Information Ce
& Business Insights
=i i + Reports |
il Common Information P Connect with Sage for tools a
il eBusiness Manager + Setup information that will help you @
& Fixed Assets most out of Sage 100.
& General Ledger !+ Utilities :
& Inventory Management Desktop
i Job Cost browser
&= Librarv Master T

""" Sage 100c benefits
@ Web Content Have a Sage 100c subscription?
& Modules I—— Content Groups Streaml|ne your workflows wﬂﬁ features
exclusive to Sage 100c subscribers.
% Favorites Leam more
E— v
Y | | < >

ABC Distribution and Service Corp. (ABC) | Accounts Receivable

Navigation pane Task pane Status bar

The following is a brief description of the main parts of the Desktop. The following
pages contain more detailed information and step-by-step instructions for the key
features.

e Ribbon — The ribbon allows you to change the current company and date, log

on as a different user, start integrated products, access modules and tasks, and
customize the appearance of the program.
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Standard Desktop

Getting Started Guide

¢ Navigation Pane — The navigation pane provides another way to switch
between modules and access web content in the Desktop browser. You can also
create a Favorites list of shortcuts to Sage 100 tasks, other programs, files, and
folders.

e Task Pane — The task pane displays the menus for the current module. You can
access tasks from the menus and search for tasks from the search field.

e Status Bar — The status bar displays the current company, module, user, and
accounting date for the current module. You can click in any of these areas to
change the applicable item. For example, click the current module to switch to a
different one.

e Desktop Browser — The Desktop browser displays web pages that are
installed with Sage 100, Sage CRM when started from the ribbon, and other
pages that are added to the Web Content group in the Navigation pane.

e Quick Access Toolbar — The Quick Access toolbar allows you to create
shortcuts to the Change Current Module and Change Secondary Company
commands and all commands on the View tab. To add one of these commands
to the tab, right-click it, and select Add to Quick Access Toolbar.

Using the Ribbon

The ribbon contains a minimum of four tabs, and you can add a Favorites tab as
well. You can minimize the ribbon so that only the tab names appear, or you can hide
it completely.

Hide Minimize

Sage 100 B - I:I| 4
Home Modules View Help ~ o
] 0 0 . . ﬂ D O r.‘
@ ﬁ a-—h a—h ® "o il -y
Change Change Change Change User Master Deferred Business Insights  Launch Sage  Launch Help
Company  Date User Settings Console Print Dashboard Fixed Assets  Sage CRM

Minimizing or Hiding the Ribbon

To minimize the ribbon, click the Minimize button. Only the tab names will appear.
Click the Expand button to restore the ribbon to it’s full height.

A - Sage 100 M - 8 x

Home Modules View Help W o-

Expand
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Standard Desktop

Click the Hide button to hide the ribbon. When the ribbon is hidden and you need to
view it, click in the area at the top of the Desktop to make it temporarily reappear.
Click the Hide button again to permanently unhide the ribbon.

Click in—| e
this area Modules ‘

to unhide o Information Cer

Ei Accounts Payable

T =

Accessing Modules and Tasks

On the Modules tab, click Change Current Module to open the Change Module
window and select a module. The current module menus then appear on the right.
You will see only the modules and tasks to which you have access based on your
assigned user role.

Sage 100
Home Modules View Help
=i @ — — — — — —
[ - | H EH EH EH H N
Change Current  Change Secondary  Ewplore  Main  Period Reports  Setup  Utilities
Module Company - d End - - - d
Actions Accounts Receivable Clear Credit Card Information

Getting Started Guide

Delete and Change Customers
Global Customner Field Change
Internet Customers Enable/Purge
Purge Accounts Receivable History
Purge Sales Tax History

Recalculate Customer High Balances
Recalculate Open Order Amounts
Remove Inactive Customers
Remove Temporary Customers
Remove Zero Balance Invoices

Sales Tax Calculation

b anh anb afb aih afl ath ael i el anb anb ob

Salesperson Commission Purge
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Standard Desktop

Getting Started Guide

Changing the Font Size

On the View tab, click Application Scaling and select a font size. The text on both the
Desktop and the task windows will be resized.

Select font size Sort alphabetically
|
Sage 100 H - O %
Modules View Help ~ o
_ O A, | Sort module list
e e aa | A 1] - &
. - - - d‘_ ) | Sort module menus
i H ication Mavigation Status Edit We
u l:l o= ae 7| Scaling -+ Pame ~ Bar - Content | Sort module menu tasks
Visual '  Default ayout Web Content Item Arrangement
Medium
Large

Alphabetizing Modules, Module Menus, and Tasks

On the View tab, in the item arrangement group, select the available check boxes to
alphabetically sort the module list, the module menus, and the tasks.

Adding the Favorites Tab

If you've created a Favorites list, you can access it from the ribbon by adding a
Favorites tab. Right-click any item in the ribbon, and select Show Favorites in the
Ribbon. For information on creating a Favorites list see To add a program, file, or
folder to the Favorites group on page 13

Using Key Tips
Press the ALT key to view key tips indicating which keyboard shortcut keys activate

the associated options. When the key tips are visible, press the specified key to
select an option.

Key tip

Sage 100 M - O %

I-ﬁlﬂes"-\ﬁr ~ ©
BV V. W o= 0

Change Change Change Change User Master Deferred Business Insights Launch Sage  Launch Help
Company  Date User Settings Console Print Dashboard Fixed Assete  Sage CRM
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Getting Started Guide

Using the Keyboard to Access Modules

You can use keyboard shortcuts to change the current module.

To use the keyboard to change the current module

1 Press ALT.

2 Press M.

3 Press C and then H. The Change Module window opens.

4 Type the first letter of the module name to select that module. If two modules
begin with the same letter, type the letter twice. Alternately, use the Up Arrow
and Down Arrow keys to highlight a module.

5 Press Enter.

Using the Navigation Pane

The navigation pane allows you to change the current module, open web pages in
the Desktop browser, and create a Favorites list with shortcuts to Sage 100 tasks,
files, folders, and other software programs.

Switching Between Open and Collapsed View

You can keep the navigation pane open so that the content is always visible, or you
can use the collapsed view to save space. When using the collapsed view, click the
pane to view the content.

Open Collapesd
Click to collapse
Modules < > Click to
= open
I Accounts Receivable - —_
ﬁ Bank Recondiliation
ﬁ Bar Code
ﬁ Bill of Materials
ﬁ Business Insights 4
= =
& Common Information -8
- =
i/ Customer Relationship Management Click and drag Click to
i eBusiness Manager i to adjust width view
ﬁ General Ledger . content
= Click to
il Inventory Management
_ - scroll down
&= Librarv Master -
@ Web Content &
Select content
& Modules group to control =]
) what appears in
W Favorites ] the pane W
v W
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Getting Started Guide

Accessing Modules and Tasks

Use the Modules group in the navigation pane to select the current module. The task
pane is updated as you switch modules.

Click menu names to expand and collapse them, and click task names to open the

tasks.

Use the search box to search for a task. The search results include all matching
tasks for which you have the appropriate security setup, even if they are not in the

current module.

Navigation pane

| Comman Information

| eBusiness Manager

Current
module —

| Il i K| K| K B B Ej

General Ledger

| Inventory Management

| Material Requirements Planning
| Paperless Office

| Payroll

| Purchase Order

Return Merchandise Authoriza. ..
| Sales Order

| Waork Order

@& Web Content
& Modules

W Favorites

Modules <

| Business Insights -

Task pane

Search for
ataskin
any module

- Budget

b sl il

D oael

Automatic Budget Copy
Budget Maintenance
Budget Report

Budget Revision Entry

Budget Revision Register

+ Explore

- Main

LD aib aib aglb

S0 gib [S0

b

Account Inguiry

Account Maintenance
Allocation Entry

Daily Transaction Register
General Journal

General Journal Entry
Recurring Journal

Rerurrina Tnurnal Ftry
-
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Standard Desktop

Viewing Web Content

When you click a link in the Web Content group, it opens in the Desktop browser.

You can add links to this group.

To add links to the Web Content group

1 On the ribbon, click the View tab.

2 Click Edit Web Content.

B&E & -
Home Modules
® @ d a4

g J = %

3 Click New, and then click Link.

Visual

AL
Mavigation Status
Pane ~ Bar -

Layout

Add links to
Web Content
~ O
A= | Sort module list
|
© | Sort module menus
Edit Web
Content | Sort module menu tasks
Web Content Item Arrangement

4 Inthe Link window, enter a URL and the title that you want to appear in the Web
Content group.

Link

Link Editor

URL: | http://www.sage.com

Title: | Sage|

Cancel

5 Click OK.

The link is added to the Web Content group of the navigation pane.

For more information about the browser, see Using the Desktop Browser on

page 14.

Getting Started Guide
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Standard Desktop

Creating Favorites

You can add shortcuts to Sage 100 tasks, files, folders, other programs, and web
pages to the Favorites group.

To add a Sage 100 task to the Favorites group

There are two ways to add a task to your Favorites list:

Drag the task from the task pane to the Favorites group.

On the task pane, right-click a task, and then click Add to Favorites.

To add a program, file, or folder to the Favorites group

There are several ways to add a shortcut to a file, folder, or another program to your
Favorites list:

Drag a shortcut from your Windows desktop to the Favorites group.
Drag a program from the Windows Start menu to the Favorites group.
Drag a file from a File Explorer window to the Favorites group.

Right-click in the Favorites group and then click Insert Shortcut. In the Shortcut
window, browse to the item and enter a title.

Shortcut E3

Shortcut Editor

Item: | C:VProgram Files (x86)WMicrosoft Office\Office 14\WINWORD EXE =

Title: | Word|

To add a shortcut to a web page to the Favorites group

There are two ways to add a web page link to the Favorites group:

Getting Started Guide

In the Web Content group, start dragging a link. The link will be automatically

added to the Favorites group.

Browse to the web page using Internet Explorer, and then drag the web page
icon from the address bar or the tab to the Favorites group.

e — https://www.sage.com/ O ~ & &

File Edit ew Favorites Tools  Help
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Standard Desktop

Using the Desktop Browser

The browser embedded in the Sage 100 Desktop is used to display web pages
accessed from the Web Content group, visual process flows, and Sage CRM when
started from the ribbon.

You can have multiple tabs open at the same time and drag the tabs to rearrange
them.

To open a tab in an external browser window, right-click the tab and then click Open
in New Window.

For more information on the web pages that are installed with Sage 100, see About
the Desktop Web Pages on page 31

Desktop browser

BA- @& - Sage 100 A = [ %
Home Web Content Modules Favorites View Help ~ = o
— ] — — — — — —
=1 {a} E EEEEE
Change Current Change Secondary  Explore Main Period Reports Setup Utilities
Maodule Company v - End - v v v
Actions Accounts Receivable
> | Search all tasks.| P (fgy Information Center (e -]
+ Explore
+ Main
] [ ]
a .
S+ Period End Information Center
o]
= + Reports s
Connect with Sage for tools and
information that will help you getthe
+ Setup .
most out of Sage 100.
______ + Utilities
@
]
* Sage 100c benefits
Have a Sage 100c subscription? Streamline your workflows with features v
< >

ABC Distribution and Service Corp. (ABC) | Accounts Receivable
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Classic Desktop

Classic Desktop

This section describes the classic Desktop. For information on the Standard
Desktop, see page 6.

Menu

Find Ta

Module Menus
|

sks Custom Buttons

Desktop Web

d Sage 100

[E=NHoR =5

Standard Butto

Toolbar |

Web [ ile

Navigation =
L

Q@
Address Bar

Modules My Tasks View H
R eZ~T il
QIR @

ip| [Main Reports PeriddEnd Setup Utilities Custom Reports Explore Custom Process Flows |
@ |[B M= 0jomook E]customer Maintenance |
L Find Task =] 2

——1 ' Address |C:\5age\sage 100 Standard 2014\MASS0'Launcher himl\welcome. htm

Tasks ' Web Content |
Information Center

£ Sage 100

Information Center
-] Resources
Modules and Tasks Feature Tours

Tasks | My Tasks

& Private Sample 1
[E] customer Maintznance
[E] Repetitive Invoice Selection
[E] nvoice Data Entry
[E] cash Receipts Entry
Private Sample 2
(=G Public Sample 1
[E] Display Dashboard
[E] start Automatic Dashboard Update
[E] Report Manager
&9 Public Sample 2

Business Insights Dashboard
1) Modules

Exit Sage 100

toution and Servicd - Lic oa

ABC Distribution an JWSmith

(<15

On the Tasks

select a module's
menu to display the
Tree View in the

Desktop.

é NOTE

You can undock
the Tasks and My
Tasks tabs from
the Desktop as a
stand-alone
window. For
more information,
see Changing the
Desktop's View (]
on page 21.

Status
Bar

Connect with Sage for tools
and information that help you
get the most out of

Sage 100.

Sage Payment Solutions

Activate payment management within Sage
100 to gain real-time visibility into your cash
flow and simplify your A/R workflow.

. company’s success.
Sage Payment Solutions e

Sage Payroll Services

Sage City
Connect with your peers and product experts
to see what others are up to.

Sage University

needs.

S| Sage 100

les My Tasks iew Help Main Reports PeriodEnd Setup Wtities Custom Reports Explore

E0E @S =%W 0H

H&E| Find Task 9| »

Sage Payroll Services

Now integrated with Sage 100, Sage Payroll
Services offers a broad array of cloud based
payroll and HR services to power your

Learn from beginning and advanced training
offered in a variety of formats to meet your

Address |CiProgram 100

Tukorials.ht;

tab,

— [ Tasks | web Content |
Tasks | My Tasks
Accounts Receivable - Main
Information Center Al | || @up one tever..
e [ customer Mantnancs
FoalxoTours [ customer ngury
Business Insights Dashboard i
e et Erermtve o ey
Repetitive Invaice Selection .
o et i e iy Tree View
ights
() wisual Process Flows [ mwsice prnting
Paperless Office [Hlsaes soumal
General Ledger [Elcash Recerpts ertry
1= ) Accounts Receivable [Slcash Receipts Journal
== MEn [FEloaily Transaction Register
[E5] customer Maintenance
] customer Inqurry
1 Irrvoice History Inquiry
] Repetitive Invoice Entry
[E5] Repetitive Irwoice Selection
[E] 1nvoice Data Entry
Invoice Priting
[=] sales Journal U
] <ash Receipts Entry
[=] cash Receipts Journal
[ Daily Transaction Register
=) Reports
{1 Period End
Setup
Utiities
Custom Reports
Explore
{1 Custom Process Flows
Customer Relationship Management ~
ABC Distribution and Service Carp. (ABC) Accounts Recefable Jwsmith 5/31/2010

e Menu Bar — The menu bar consists of the standard menus that provide access to
module tasks and other features. You can use either the mouse or the keyboard
to select the menus. For more information, see Using the Keyboard to Access
Modules on page 30.

Toolbars — The six toolbars that appear are the Standard Buttons toolbar, Web
Navigation toolbar, Module Menus toolbar, Custom Buttons toolbar, Find Tasks

toolbar, and Address Bar toolbar. For more information about each toolbar, see
Using Toolbars on page 16.

Getting Started Guide
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Classic Desktop

é NOTE

You can hide the
Desktop Web
pages or Tree
View by clicking
the Detail View
button on the
Standard Buttons
toolbar. For more
information, see
Changing the
Desktop's View
on page 21.

Getting Started Guide

Tasks Tabs — The Tasks tabs provide a representation of the menu organization.

My Tasks Tab — The My Tasks tab allows you to add tasks and external programs
you frequently use into private task folders for quick access. For more
information, see My Tasks on page 27.

Desktop Web Pages — The Web pages available are the Information Center page,
Resources page, Feature Tours page, and Business Insights Dashboard page.
For more information, see About the Desktop Web Pages on page 31.

Tree View — On the left Tasks tab, select a module to display the Tree View. The
Tree View provides a visual representation of module menus and tasks. For
more information, see Tree View on page 26.

Status Bar — The Status Bar displays the currently selected company name and
code, active module, user logon, and the active module's accounting date. When
you select a new task from the Desktop, the Status Bar updates to reflect the
newly selected module and the module's accounting date. If you previously
accessed other modules, their existing company and accounting date do not
change. You can click the company, module, user logon, or accounting date area
on the Status Bar to make changes. For more information, see Learning
Common Procedures on page 43.

Using Toolbars

The Desktop displays six toolbars that you can optionally show or hide. To toggle
toolbars on and off, select View > Toolbars and select the toolbars to show or hide.

Click and drag the grab bar to the left of each toolbar to resize
and move the toolbars. Also, double-click the grab bar to
automatically resize the toolbar to its optimal size.

© File Modules My Tasks View Help L Main Reports Period End Setup Utlities Custom Reports Explore
P B I;j @ Jég') £ V\) O Te| | [Elcustomer Maintenance |D]OUTLOOK § Caleulator

@ s | % *| ! Find Task |report manager v &
! Address [¥] stop 3~
lg'] Refresh F5

» Home Cirl+Home

When you resize a toolbar, click
the More Options button to access
the hidden toolbar buttons.

All toolbars display by default and are explained in the following pages:

Module Menus Toolbar on page 17
Standard Buttons Toolbar on page 18
Custom Buttons Toolbar on page 19

Web Navigation Toolbar on page 20
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software is first
started, the
module-specific
menus default to
the Library
Master menus.
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Find Tasks Toolbar on page 21

Address Bar Toolbar on page 21

Module Menus Toolbar

The Module Menus toolbar displays module-specific menus for the active module.
Depending on which module is active, the toolbar updates to reflect the current
module's menus.

| Main Reports Period End Setup Utilities Custom Reports Explore|

The following menus are accessible from this toolbar:

The Main menu lists the primary functions for a specific module (for example,
master file maintenance and data entry tasks).

The Reports menu lists the standard reports available for the module.

The Period End menu contains the period-end processing tasks appropriate for
the module.

The Setup menu contains the module's setup tasks and other maintenance tasks
necessary to prepare a module for normal processing.

The Utilities menu contains additional maintenance tasks for the module.

The Custom Reports menu contains default SAP® Crystal Reports® and reports
added using Report Manager and the Business Insights Reporter Wizard.

For modules with Explore Views available, the Explore menu lists the views for
the module.

In addition to these standard menus, each module may have one or more additional
menus unique to that particular module.

Page 17
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Standard Buttons Toolbar

The Standard Buttons toolbar consists of buttons used to access common tasks.

Launch Sage

Change User Deferred : Detail View
; Fixed Assets
Change Company Print Help
| ‘ |
— i =l 'y t? k]
ZRE LD @
| |
Change Date Business
Master Console Insights Launch Sage CRM
Dashboard

Click the Change Company button to change companies.

Click the Change Date button to change the accounting date for the active
module.

Click the Change User button to change the user logon.

Click the Master Console button to monitor system activities. For more
information, see Master Console in the Help system.

Click the Deferred Print button to view deferred print jobs. For more information,
see Using Deferred Printing on page 61.

Click the Business Insights Dashboard button to launch Business Insights
Dashboard reports. For more information, see Dashboard Overview in the Help
system.

Click the Help button to access the Help system. For more information, see
Using the Help System on page 41.

Click the Detail View button to turn the Desktop's Detail View on or off. For more
information, see Detail View on page 22.
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The software also
provides a task to
customize your
toolbar instead of
using the drag
and drop
functionality. For
instructions, see
Opening a Task
in a Secondary
Company on
page 47.
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Custom Buttons Toolbar

The Custom Buttons toolbar is just that — customizable. You can drag and drop any
task from the Tree View onto the Custom Buttons toolbar for quick-and-easy access.
You can also drag and drop external programs and shortcuts (for example, Outlook,
Excel, or Calculator) from your desktop onto this toolbar to facilitate access to

programs you commonly use. In addition, you can rename buttons or delete them at
any time.

This task has been added to the
Custom Buttons toolbar. Click it to
display Customer Maintenance.

This desktop shortcut has been
added to the Custom Buttons
toolbar. Click it to start Microsoft

1 —
‘ [E ] customer Maintenance |_I| Microsoft Cutlook

=

= Caloulator

To add buttons

1

Use any of the following methods to add a button:

o Select View menu > Toolbars > Customize.

o Right-click any toolbar, and click Customize.

o Right-click the Custom Buttons toolbar, and select Add > Task or
Add > Program and proceed to step 3 if you are adding a task or step 4 if you
are adding an external program.

On the Customize Custom Buttons tab, click New Task to add a button for a

task.

Customize

| Taclbars | Custorn Butkons
Show Captions Tk Cancel

In the Browse window, locate the task to add and click Open.

To add an external program or desktop shortcut, in the Customize window, click

New Program.

In the Browse window, locate the program to add and click Open.
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& NOTE

If you clear the
Show Captions
check box, the
tooltip that
appears when
your cursor
hovers over the
button identifies
it.

& NoTE

The Web
Navigation
toolbar is not
available if the
Collapsed View is
displayed. For
more information,
see Collapsed
View on page 22.
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6 To provide more space on your Custom Buttons toolbar, in the Customize
window, clear the Show Captions check box to hide the text labels and display
only icons for the buttons you added.

7 In the Customize window, click OK. The task and external program are added to
the Custom Buttons toolbar.

This is an example of a Custom Buttons
toolbar with text labels and icons.

- B Customer Maintenance  [5) Microsoft Outlook | F| Caloulator

This is an example of a Custom Buttons
toolbar with only icons.

V—‘—\

=l
| - When your cursor hovers over a
| Customer Ma'”tena”'39| button, a tool tip appears to identify the

button.

To delete buttons from the Custom Buttons toolbar
1 Right-click the button to delete.

2 Click Delete.

To rename buttons on the Custom Buttons toolbar
1 Right-click the button to rename.
2 Click Rename.

3 In the Rename dialog box, type the button's new name and click OK.

Web Navigation Toolbar

Use the Web Navigation toolbar to navigate through the Web pages in the Desktop,
similar to navigating in a Web browser such as Internet Explorer.

Back Stop Home
| | |
O MR &
| |
Forward Refresh
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Find Tasks Toolbar

Use the Find Tasks toolbar to find tasks using keywords. At the Find Task field, enter
a keyword such as "accounts" and click Find. A list of all tasks related to the keyword
"accounts" displays in the Desktop.

Address Bar Toolbar

Use the Address Bar Toolbar to browse to any Web site.

: Address v f*|

Changing the Desktop's View

You can change the appearance of the software to fit your needs. The Desktop's four
basic views are:

e Detail View on page 22
e Collapsed View on page 22
e Minimized View on page 23

e Modules and Tasks View on page 24
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When you exit
the software, if
the Detail View
was the last view
selected, the next
time you launch
the software the
Detail View _l
display by —
default.

When the Detail
View is displayed,
the Detail View
button is selected.

é NoTE

When you exit
the software, if
the Collapsed
View was the last
view selected,
the next time you
launch the
software the
Collapsed View
displays by
default.
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Detail View

The Detail View displays the Desktop in its full view. In this view, you have the benefit
of using the Tasks tab to navigate through the tasks and available Web pages, and
the My Tasks tab to access public and private task folders.

Use any of the following methods to display the Detail View:
e Select View menu > Detail View.
e On the Standard toolbar, click the Detail View button.

In the Detail View, you can hide the Status Bar by clearing the Status Bar selection
on the View menu. You can also hide the Tasks and My Tasks tabs by selecting View
menu > Auto Hide Tasks. To bypass the Information Center page the next time you
start the software, select View menu > Skip Information Center Page. The Tree View
appears instead.

Elsage10 B
File Modules MyTasks View Help ~ Main Reports Period End Setup Utilities Custom Reports Explore Custom Process Flows
ZPE 2% E @ |¥]ExceL | O]oumook [E] Customer Maintenance
= A= IRERE Find Task = 2
Address |C:\Sage\Sage 100 Standard 2014MASS0\Launcher himl\welcome html -] &

L Veb Content

Tasks ‘
25 sse 100 Information Center

+-&] Information Center
-] Resources

-] Feature Tours
i) Business Insights Dashboard
{2 Modules

Connect with Sage for tools
and information that help you

get the most out of
Sage 100.

Sage Payment Solutions

Activate payment management within Sage
100 to gain real-time visibility into your cash
flow and simplify your A/R workflow.

Sage Payment Solutions

Sage City
Connect with your peers and product experts
to see what others are up to.

Sage City

Sage Payroll Services

Now integrated with Sage 100, Sage Payroll
Services offers a broad array of cloud based
payroll and HR services to power your
€OMpany's SUCCess.

Sage Payroll Services

Sage University

Learn from beginning and advanced training
offered in a variety of formats to meet your
needs.

Sana lInivarsity

ABC Distribution and Service Corp. (ABC)

Accounts Receivable Jwsmith

10/7/2013

Collapsed View

The Collapsed View hides the Tasks and My Tasks tabs, Desktop Web pages, Tree
View, and Web Navigation toolbar. Use this view if you prefer to use the Modules
menu to select tasks instead of the Modules tab and Tree View. This view is also
useful if you want more free space on your desktop. If the Status Bar is in view, you

can select View menu > Status Bar to hide it.
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Use any of the following methods to display the Collapsed View:
|E| e Select View menu > Detail View.

e On the Standard toolbar, click the Detail View button.

S Sage 100

© Flle Modules My Tasks View Help : Main Reports Setup  Utiities

BENE L5 Ok

T 1> ERENES Find Task | v 2

: Address ‘C:\Drogram Files\sage'\gage 100 WorkStationyMAS90\Launcher \Htmlwebres, htm v| od
ABC Distribution and Service Corp, (ABC) Library Master jwsmith 5312010

If you click the Business Insights Dashboard button in the Collapsed View, the
Business Insights Dashboard page displays in your default Web browser, such as
Internet Explorer.

& Note Minimized View

Select View

menu > Start The Minimized View allows you to minimize the Desktop, yet still have access to
Minimized to set most of the software's functionality. To view the Desktop in its minimized state,

the Minimized minimize the Desktop and right-click the software icon in the system tray. In the

View as the S . :

default view Minimized View, you can change the company, accounting date, and user, and
when starting the access modules and tasks.

software.

software icon

Library Masker 4
Business Insights 4
General Ledger 4
Accounts Receivable 4
Accounts Payable 4
Change Company (ABX)
Payral 4
Change Date (5/31/2010)
Inventory Management  F h User (i ithy
ange User (jwsmi
Sales Order 4 ? !
Purchase Order L4
My Tasks 4
Exit

:'.'-' start S [ S Sage 100
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When you exit
the software, if
the Modules and
Tasks View was
the last view
selected, the next
time you launch
the software the
Modules and
Tasks View will
display by
default.
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Modules and Tasks View

The Modules and Tasks View allows you to undock the Tasks and My Tasks tabs
from the Desktop as a stand-alone window. To view the Modules and Tasks View,
position your pointer over the Tasks and My Tasks panel, and click and drag the
panel to undock it from the Desktop. You can also double-click the Tasks and My
Tasks panel title bar to undock the Tasks and My Tasks tabs from the Desktop. For
more information, see the Customizing the Desktop tour available on the Desktop
Feature Tours page.

When the Tasks and My Tasks tabs are undocked as a stand-alone window, you can
move the window anywhere on the screen and resize it. The Modules and Tasks
View provides access to any module and task on the Tasks tab and any task stored
on the My Tasks tab without having the full Desktop displayed.

To re-atach the Tasks and My

Tasks | My Tasks Tasks tabs to the Desktop,
double-click this title bar. The
Desktop must be in Detail View.

== Private Sample 1
[E] customer Maintenance
[E] repetitive Invoice Selection
[E1 1nvoice Data Entry
[E] cash Receipts Entry
+ Private Sample 2
=I-{5= Public Sample 1
[E1] pisplay Dashboard
[E] start Automatic Dashboard Update
[E] report Manager
+-{5=1 Public Sample 2

Exit Sage 100

ABC Distribution am JWSmith

Accessing Modules and Tasks

The software provides several ways to access modules and tasks. You can access
modules from the:

e Modules Menu on page 25

e Module Menus Toolbar on page 25
e System Tray on page 26

e Tree View on page 26

e My Tasks on page 27

e Find Tasks Toolbar on page 29

e Using the Keyboard to Access Modules on page 30
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Modules Menu

The Modules menu allows you to select any of the tasks that are installed on your
system. You can use your mouse to select tasks from the Modules menu, or you can
use the keyboard to select the Modules menu by pressing ALT+O, and typing the
underscored letter of the module and task to access.

Forinformation on
this task, see
Changing the
Module on
page 47.

The current
module is
indicated by a
check mark next
to the module
name.

S Sage 100

: Eile mMyTashs Wiew Help

P Ea Switch To...

: L) ! Library Master

; Addrd Common Information
ABC Dist Business Insights

Paperless Office

General Ledger

Main Reports Period End Setup Utilites Custom Reports Explore

[El] Customer Maintznance  |©] OUTLOCK.

(@)
~|| B

£ Calculator

590 auncher thtmlthome. himl

s

Accounts Receivable

jwsmith

5/31/2010

v Accounts Receivable m E] Customer Maintenance

Accounts Payable
Payrall

Inventory Management
Sales Order

Purchase Order

Return Merchandise Authorization

Job Cost

Bill of Materials
Work Order

Bank Recondiliation

Electronic Reporting

Reports

Period End
Setup

Utilities

Custom Reports

Explore

Module Menus Toolbar

* [E] Customer Inguiry
3 E| Invoice History Inquiry
¥/ [E] Repetitive Invoice Entry
¥ B Repetitive Invoice Selection
r Invoice Printing
[E seles Journal
[E] Cach Receipts Entry
[E cash Receipts Journal
[= Daily Transaction Register

The Module Menus toolbar displays module-specific menus and tasks for the active
module while the Modules menu is a cascading menu that displays menus and tasks
for all modules. From any menu, select a task.

The current
module appears
on the Status

S Sage 100

File Modues MyTasks View Help

EEE @ L% % @) BEE cusomerMantenance

NN

‘) eecorts BeriodEnd Setup Usiities Custom Reports  Explore

¢ i Task [ | ] Customer Inquiry

Address |C:\Program Files\sage\Sage 100 E] nvoice History Tnquiry

ABC Distribution and Servi

Accounts Recei

Bar.

Getting Started Guide

E] tnvoice Data Entry
[F Invoice Printing

[E] sales Journal

[E] CashReceipts Entry

[E] CashReceipts Journal
[E] Daily Transaction Reaister

[E] Repetitive Invoice Entry
] Repetitive Invoice Selection

DUTLOOK £ Calculator

L;)
L ¥

(ad

5/31/2010
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For more
information about
the Minimized
View, see
Minimized View
on page 23.

& Note

When you use
the Tree View,
the active module
is not changed
until you select a
task in another
module.

System Tray

When the Desktop is minimized, you can right-click the software icon in the Windows
system tray to access tasks.

E Aged Invoice Report Open Tkem Cust

Main
E Customer Sales Analysis Reports
E Salesperson Commission Report

Setup

E Customer Listing

‘s start

7 & | § sage 100

Period End

software
Library Master 4
Business Insights 4
General Ledger 4
| Accounts 4
b | Accounts Payable 4
v I ' Change Company (AEX)
ayrol
i Change Date {5/31/2010)
b | Inventory Management # . i
Change User {jwsmith)
Sales Order 4
Purchase Order 4
Iy Tasks 4
Exit

Tree View

The Tree View provides another alternative for selecting tasks by visually
representing the menu organization in a tree-like structure in the Desktop. On the
Tasks tab, select a module to display the Tree View.

You can expand
or collapse each
branch of the
menu structure to
show as much, or
as little, detail as

S Sage 100

File Modules My Tasks View Help

QO HR &

Main Reports

E0RP2%%8 0F
Find Task | 2

PeriodEnd  Setup Ukilties Custom Reports  Explore

acéress |CiiProgram 100

auncher|HimliTutorials.h

Tasks | My Tasks |

ﬁ

Information Center
Resources
Feature Tours

Business Insights Dashboard
= Modules

(- Library Master

Common Information

Business Insights

[ Wisual Process Flows
) Paperless Office
General Ledger
(== Accounts Receivable

you want.

Click a task to
access it, or

=17 Main

[E] Customer Maintenance

Tasks | web Content |

[E] Customer Inquiry

[E] tnvoice History Inguiry

[E] Repetitive Invoice Entry
[E] Repetitive Inveice Selection
[E] tnvoice Data Entry

[ trweice Printing

[ sales Journal

[E] Cash Receipts Entry

right-click a task
toopenitina
secondary
company.

Getting Started Guide

[ Cash Receipts Journal
[= paily Transaction Register
Reports

Periad End

Setup

litie:s

{9 Custom Reports
Explore
Custom Process Flows
-7 Customer Relationship Management

Accounts Receivable - Main
#Up one level...

Bl custamer markeranes |
[E customer Inquiry
[Elinvoice History Inquiry
[ERepetitive Invaice Entry
[EdRepetitive Invoice Selectior
[Eltrwoice Data Entry
[Hirwoice Printing

[E5ales Journal

[ Cash Receipts Entry
[Flcash Receipts Journal
[Epaily Transartion Register

1 This is the Tree View. The Tree
View shows the tasks available
from the menu selected on the
Tasks tab. To access a task,
click it. You can also right-click
any task to open itin a
secondary company. For more
information, see Opening a Task
in a Secondary Company on
page 47.

ABC Distribution and Service Corp. (ABC)

Accounts Receivable jusmith 5/312010
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For instructions
on how to
customize

My Tasks, see
Opening a Task
in a Secondary
Company on
page 47.

My Tasks

You can also access tasks by adding them to the My Tasks tab. The My Tasks tab is
an area where frequently-used tasks, such as inquiry programs, desktop shortcuts,

and external programs can be added to public or private task folders and stored for
quick access. Instead of accessing commonly-used tasks from the Modules menu or
leaving the software to start another program such as Microsoft Word, you can add

the window or program to a task folder and click the task to launch it.

Public task folders, indicated by the green plus sign, are available to all users and
are stored on the server.

Select the My
Tasks menu to
select a task and
display the same
public and private
task folders that
appear on the My
Tasks tab.

The green plus
sign marks public
task folders. Click
a public or private
task folder to
display its
contents, and
click a task to
open it.

Getting Started Guide

S Sage 100

——File—adules Yiew Help Main Reports Period End Setup Utilities Qustom Reports  Explore
BB @ BB = iscley Dashboard OUTLOOK & Calculator
i< X M| Public Sampls 2 »| ] Start Automatic Dashboard Update vl B
Caddess [CPrO gy sy o ] RepOrt Manager i v &
= Private Sample 2 ¥ = Colaiator
Tasks | My Taski—,
Sage 100 ERP
[ Private Sample 1 &]1nformation Center
Private Sample 2 @Resuur(es
26 %b"afpa.amfﬁ;hmd &]Festure Tours You can drag and drop tasks into
[E] Start Automatic Dashboard Update :1”2”755 IsichiEad bead task folders. You can also drag
Report Manager PR o
£ Calculatar and drop shortcuts and programs
& Public Sampe 2 from your desktop into task
folders.
ABC Distribution and Service Carp. (ABC) Accounts Receivable wsmith 5i31/2010
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Private Tasks

Private task folders are available to individual users and can only be accessed on
the workstation from which they are created. Private task folders allow individual
users to customize their own tasks on their workstation.

To create private tasks

1 Right-click in the My Tasks tab area, and select New > Private Folder.

S Sage 100

: Eile Modules My Tasks View Help : Main Re
T BEERE @%@ % | Hc
E @ (=) = B : Find Task

! Address |C:\Program Files\sage\Sage 100

|
Tasks | My Tasks |

fam Private Folder

Reload My Tasks

Ed]

2 Type a name for the new private task folder.

3 Right-click the folder, and select New > Task to add a task.

4 In the Browse window, select the task to add and click Open.

5 Right-click the folder, and select New > Program to add an external program.

6 In the Browse window, locate and select the external program to add and click
Open.

7 Repeat steps 3-6 to add additional tasks or external programs.

8 Access the private task folder from the My Tasks tab or the My Tasks menu.

S Sage 100

: File Modules MyTasks View Help : Main Re
B8 92 «% |08 E
e HEA @ ! Find Task

‘ Address [C:\Program Files\sage \Sage 100

=

My Tasks
Task folder Tosks | My Tosks |
-, = o pETE

[EX] customer Maintenance
[EX] Repetitive Invoice Selection

EX tnvoice Data Entry
[E] cash Recsipts Entry
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To create private tasks using the drag and drop method

1

In the Desktop's Tree View, click the task to add to the private task folder and
hold down your left mouse button.

Drag the task from the Tree View to the private task folder on the My Tasks tab.

When the private task folder is highlighted, release the left mouse button to drop
the task into the folder.

From your computer desktop, click the shortcut (for example, Word, Excel, or
SAP Crystal Reports) to add to the private task folder and hold down your left
mouse button.

Drag the desktop shortcut to the private task folder on the My Tasks tab.

When the private task folder is highlighted, release the left mouse button to drop
the desktop shortcut into the folder.

Find Tasks Toolbar

The Find Tasks toolbar allows you to find tasks using keywords. At the Find Task
field, enter a keyword such as "invoice" and click the Lookup button. A list of all tasks
related to the keyword "invoice" appears in the Desktop. You can then click a task
from the list to access it.

S Sage 100 =1l

: Ele Modules My Tasks View Help : Main Reports PeriodEnd Setup Utilities Custom Reports Explore
TR E QL L T @ T ElcustomerMantenance [~ OUTLOOK | Calculator
N ¥ [2 A  Find Task (invaice: v B2
Type a keyword LR izl ' — =
.  Adddress |C:\Pragram FilesiSagelSage 100 WorkSkation|MASS0lLauncheriHimlwebres. him ~ | &
and then click the = -
Tasks | wreb Content
Lookup button. Tasks |y Tasks
S Task Module Location [
= [ Sage 100 [Eltnwoice History ... eBusiness Mana... Inquiries
] Infarmatian Center Eltnvoice History I...  Bar Cods Inquiries
2 E::i‘l‘r';zms [ 30b Invoice Printing  Job Cost Job Billing
)~ P e N— Elcreate C\jlstumer‘ .. Return Mercha.., Ut\htle.s
55 Moduios Elinvoice History I...  Return Mercha...  Inquiries
E|Rece\pt of Invaic...  Purchase Order Main
Shipping History I... Sales Order Explore
Elnvmce Histary I...  Sales Order Inquiries
Invmce Printing Sales Order Shipping
o Generate In... Sales Order Main
woice Prinking Sales Order Iain
[Elinvoice DataEntry  Sales Order IMain
Elvendor Repetitiv,,,  Accounts Payable  Explore
Edvendor Cpen Inv... Accounts Payable  Explore
Vendor Histary In,., Accounts Payable  Explore
[Elremove zero Bal...  Accounts Payable  Ltiities
[Elaccounts Payabl...  Accounts Payable  Reports
[Elopen Invoice by ... Accounts Payable  Reports
[Elaccounts Payabl...  Accounts Payable  Reports
[Elinvoice Payment ... Accounts Payable  Check Printing and ...
[Elinvoice Register  Accounts Payable  Main
[Elinvoice DataEntry  Accounts Payable  Main
[Elrepetitive Invaic... Accounts Payable  Main
[Elrepetitive Invaic... Accounts Payable  Main
Fltunice ickarsr T Arcounbs Pawable  Main b
ABC Distribution and Service Corp. (AEC) Accounts Receivable Jusmith 5i31/2010
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Using the Keyboard to Access Modules

You can use your mouse to display a menu from the menu bar or Module Menus
toolbar, or you can use any of the following alternative keyboard methods:

e Use the ALT key plus the underscored letter of the menu: To directly select a
menu. For example, to select the Main menu, press ALT+M.

e Use the arrow keys: To select a menu to the right of the one presently selected,
press the RIGHT ARROW key. Each stroke of the key moves the selection one
step to the right. To move to the left, press the LEFT ARROW key. As a different
menu is selected, the menu title is highlighted to distinguish it from the other
menus.

When the appropriate menu appears, select the task to access by using the
following method:

e Use the arrow keys: Use the UP ARROW and DOWN ARROW keys to highlight
the desired task. When the menu first appears, the first task is highlighted. After
you highlight a task, you can access that task by pressing ENTER.
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About the Desktop Web Pages

The Desktop Web pages available are the Information Center page, Resources
page, Feature Tours page, and Business Insights Dashboard page. To display a web
page, select the page from the Web Content area (standard Desktop) or the Tasks
tab (classic Desktop).

BA- @ & - Sage 100 B - o x
Home Web Content Modules Favorites  View Help ~ = 0
— ] — — — — — —
=] fa} E EEEEE
Change Current Change Secondary  Explore MWain Period Reports Setup Utilities
Maodule Company - - End - - -
Actions Accounts Receivable
> Search all tasks. |2 'Zrijlnfnrmation Center (< N>
+ Explore
+ Main
'y []
] .
=+ Period End Information Center
8]
= + Reports :
Connect with Sage for tools and
information that will help you get'the
+ Setup _
most out of Sage 100.
______ + Utilities
%
]
* Sage 100c benefits
Have a Sage 100c subscription? Streamline your workflows with features v
v o N
£ >

ABC Distribution and Service Corp. (ABC) | Accounts Receivable

Information Center Page

From the Information Center page, you can find information about integrated solutions and
Sage training and support. There is also a Feedback Site link; click the link to provide your
ideas and feedback directly to Sage.
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BA- @& - Sage 100 B - 0 x
Home VWeb Content Modules Favorites  View Help ~ = 0
— 3 — — — — — —
=] a} E EEEEE
Change Current Change Secondary  Explore Main Period Reports Setup Utilities
Module Company - - End - - - -
Actions Accounts Receivable
> Search all tasks. |2 {Fﬁ Information Center x | (75 Resources ® (-]
+ Explore ~
+ Main
40
C
2 i R
8 + Period End esources
2 +Report
+ Reports
= P The resources below offer helpful
information about Sage 100.
+ Setup g
______ + Utilities
@
=]
e Help Center
Learn detailed information about V
N < >

ABC Distribution and Service Corp. (ABC) Accounts Receivable

Resources Page

From the Resources page, you can access the What's New page to learn about the latest software
enhancements, view this Getting Started Guide, the Customer Upgrade Guide, and module overview
documents, access the product’s Help system, and view file layout and program information.
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BA-& @ - Sage 100 m - 0 x
Home Web Content Modules Favorites  View Help ~ = 0
— 3 — — — — — —
=1 {a} E EEEEE
Change Current Change Secondary  Explore Main Period Reports Setup Utilities
Module Company - - End - - - -
Actions Accounts Receivable
> Search all tasks. |2 i'ijlnfnrmatinn Cent r@ Resources b4 r;} Feature Tours X G e
+ Explore
+ Main
40
3
E  +Period End Feature Tours
2+ Report
+ Reports
= P Watch these feature tours to learn about
the most useful features in Sage 100.
+ Setup
______ + Utilities
@
=]
The feature tours that are listed by name are installed with the product and
* require the latest Adobe Flash Player. The links with the globe next to them will
take you to a website with additional tours. An Internet connection is required to v
W
£ >

ABC Distribution and Service Corp. (ABC) Accounts Receivable

Feature Tours Page

From the Feature Tours page, you can watch videos that demonstrate how to perform various Sage 100
tasks such as entering data, using the inquiry features, and creating custom reports. The page also
includes a series of tours on Business Insights Explorer.
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B& & - Sage 100 B - 0
Home Modules View Help ~
B | 9 = | S =
@ ﬁ an aa F‘@ = ull L=
Change Change Change Change User Master Deferred Business Insights Launch Sage  Launch
Company  Date User Settings Console Print Dashboard Fixed Assets  Sage CRM
»  |Searchall tasks |P Information Center X | Business Insights Dashboard ¢ | Business Insights Dashboard X
+ Dashboard ABC As of May 31, 2020
Maodify this Page
Distribution and Service Corporation
+ Explorer
+ Reporter Leverage Ratios Profitability Ratios
1.0 0.50
0.45
3 0.9 0.40
3
3 08 0.35
= 0.30
0.7 0.25
0.20
06 015
’ | 0.05
0.4 I | 0.00 — —
Equity Debt Debt to Equity Income Profit Expenses Return
...... [ Period to Date [ Period to Date
B |7 prior Period |7 prior Period
Year to Date
= Period to
Date Prior Period Period to Prior| Year to
7 Equity Ratio 0.50 0.55 Date Period Date
Debt Ratio 0.50 0.45 Met Income to Sales 0.00 0.17 0.08
v | NMaht tn Eauitu Rakbin 1 nn nao Croace Denfit o Calne n a7 nAg N0 I
] ] ]

| »

m

Business Insights Dashboard Page
The Business Insights Dashboard page provides a customizable graphical summary of your
company’s financial data.
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é NoTE

The task
windows
appearance will
vary depending
on which theme
is selected in
Company
Maintenance, but
the functionality
is the same.
The examples in
this section use
the Classic
theme.

Becoming Familiar with Maintenance and Data Entry
Windows

Throughout the software, maintenance and data entry windows share a common set
of controls which make learning the software quick and easy. Before you begin
entering data and performing common tasks, let's look at examples of these

windows.

Sample Maintenance and Data Entry Window

This sample window shows common data entry features shared by maintenance and
data entry windows. Some features may not appear in all windows.

The window's title bar

displays the current company

and accounting date.

E|Aa"R Invoice Data Entry (ABC) 5/31/2020

Invaice Number | 0100057-IN | G

Customer No

Customer PO

Invoice Date
Due Date
Discount Date
et Invoice Amt

Sales Tax

2. Lines

3. Totals

4 b b E

4. Payment

[01-a8F

513172020
B/30/2020
513172020

"
&
)
X
A

Schedule  [WIMILMIL %

Wiwaukee

Quick Print... @

Terms Code

Ship Method
Salesperson

Comment

Print Invoice

Fax

Selects first, next,

last, and prior

records.

‘Ck E% f£| American Business Futures

01 (@, MNet30 Days
UPS BLUE, Q,
0100 |G Jim Kentley

- [m]

Customer...

Credit...

Click the Print
button to print

L 1]

E-mail

|artie@sage.aample.cnm

|I'_J

the report
associated with
this window.

Click the Office J

Merge button to
access Office
Template
Manager or
Custom Office.

Getting Started Guide
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Click Accept when all

information is correct and

you are finished with the

current record.

Click Cancel to
remove the

information entered.

Click
Delete to
delete the
record.

To resize the
window, click here,
hold down your left
mouse button, and
drag the window.
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é NoTE

For more
information about
personalizing
grids, see the
Entering Data
tour available on
the Desktop
Feature Tours

page.

To locate a
specific row, type
the number of the

Sample Accounts Receivable Line Entry Window

This sample Accounts Receivable Lines tab window shows common grid entry
features shared by data entry windows in modules other than Material Requirements
Planning and Work Order.

In addition to the features illustrated below, you can personalize a data entry grid to
allow for fast and efficient entry of data. Most columns in a grid can be moved,
resized, or hidden. You can also freeze a column of data so that a particular column
remains in view during scrolling. You can resize the data entry window, and the
Primary and Secondary grids as well. All personalizations to grids are saved for your
future data entry sessions.

; ; Click the
row to view at this &l A/R Invoice Data Entry (ABC) 5/31/2020 - o x Caloulat
field. Click the alculator
Find Row button to Invoice Number |0100057-0 O [ 14 4 b bl [ Customer..  Credit.. button to
access the
US.e the Search 1. Header 2. Lines 3. Totals 4. Payment Calculat
Grid window for : ?cu ator
entering criteria to ; = =] window and
’ Quick Row a @ @ 554 E o
find rows that 1 - calculate a
contain specific ltem Code Quantity Price Amount Comment value to return
information. 1 | WIDGET 1.000 55,250 55.25 to this field.
2 |2000A 1.000 88.000 88.00 Buttons in grids
o BEN =7~ 1.000 | 220.00 do not appear
Th.ls N the. & 000 00 until focus is on
Primary grid. It the field
contains the main
data entry fields.
< >
This is the —
Secondary gl'id. It Description 19" Gadget with Wheels A~
. GL Account | 400-01-00
contains
. . Cost 75.000
information for the
. Tax Class ™ o
row selected in the
Primary grid. Net Invaice
- Reset
cussr. @ EZEETEEE S 0|  rowano
Reset All
Delete Row —
Rows
1]
Insert Row
I
Move Row Up  Move Row Down

é NoTE

For more
information about
the right-click
menus, see the
Feature Tours
available on the
Desktop Feature
Tours page or the
Help menu.

Getting Started Guide

Another feature of data entry windows in modules other than Material Requirements
Planning and Work Order is the right-click menu.

You can right-click outside of a grid to access system information and other

tasks.

You can also right-click any field in a grid to access additional tasks related to the

field.
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Right-click outside of a grid to
access these options. Click

A/R Invoice Data Entry (ABC) 5/31/2020 — [m] X . . .
B R invoice Data Enry System Info to view information
nvoice Number [0100057- (O [ 1 4 B bl [ ErEFTEE- i GERE such as the current user. Click
1 Header 2 Lines 2. Totals 4 Payment Panel Settings to launch the
ST Customizer module if it is installed
i 5 = = - .
S P | eneisettings » |[ERELS or to click Reset Form to reset the
tem Code Quantiy rice EEEEES D Comment form back to its default settings.
1| WosET 1000 ss250 sz Click Related Tasks to select and
2 |200-04 1.000 22.000 22.00 . .
2 |287.6a & 1.000 220,000 22000 navigate to a listed task.
4 000 000 00
[ A/R Invoice Data Entry (ABC) 5/31/2020 - m] X
S Invoice Number 0 T-IN O\, 4 4 B B = Customer. Credit
Description | 197Gad0g 4 peager 2. Lines 2. Totals 4, Payment
GL Account | 400-01-00|
Cost L - = == .
TaxCiass | TX QuiccRow EI ERCER Right-click any
ltem Code: Quantity Price J Amount Comment f|e|d inside a
I oce 1.000 : gE ==~ 55.25 .
e e Info grid to access
- > |200DA 1.000 . 5.00
Quick Print.. () 3 |287-GA 1.000 ZrElEEigs P e tasks and
a a00 RelatedTosks  * | g options related
LrREE to the field.
Show Column
@Mwa Row Up
{EMD!E Row Down N
< @jnsert Row
Description | 8 x 107 Widgets ~ | B¢ Delete Row
GL Account | 400-01-00 S5/Reset Row
Cost 27.500 Reset All Rows
Tax Class | TX v & Find
Switch Grid
Freeze Column it Invoice 363.25
ﬁ&ponto Excel

Understanding Basic Types of Data

During data entry, you may need to enter the following basic types of data.

Text

Unformatted entries of alphabetical information (for example, names, addresses,
and comments) are text entries.

é NOTE
The M/dlyyyy
format is the
default date
display format.
The format of the
date is set from
the Windows
Control Panel.

Dates

Enter a two-digit month (MM), followed by a two-digit day (DD), followed by either a
two-digit (YY) or four-digit year (YYYY). Six or eight characters can be entered for
the date. If a two-digit year is entered, the century is determined by the century
preferences setting in the Windows Control Panel.

You do not need to put a hyphen (-) or slash (/) between the day, month, and year;
punctuation is inserted automatically. For example, to enter May 31, 2010 at a data
field, type 053110. (Do not forget the leading zero.)
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Numeric Data

Empty numeric fields (zero value) display a mask indicating the number of digits that
can be entered to the right of the decimal point. For example, .00 appears if the
numeric field accepts two-decimal precision.

Some numeric fields (for example, quantity and hour fields) do not assume the
decimal point.

To enter negative numbers, type the negative sign (-) as either the first or the last
character of the entry.

Account Numbers

General ledger account numbers are structured fields consisting of one or more
segments separated by a hyphen (-) or other separator selected at the Account
Number Separator field in Account Structure Maintenance.

You can enter the value for each segment separated by a hyphen (-). You can also
zero, or blank fill, each segment to its maximum number of characters without using
the hyphen (-).

Example: An account field with a mask of #H##H#-#-tHHE-H#iH-##H processes your
entry in the following manner.

Your Entry... Displays As...

1-2-4-6-800 00001-02-004-006-800
1234567891234567 12345-67-891-234-567
010005 01000-05-000-000-000
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Sorting and Selecting Dialog Box Data

You can sort data in columns in ascending or descending order by clicking the
column heading. Click a column heading to sort the data in reverse order. Resize the
column headings by clicking and dragging between the columns.

Dialog Box Example

Column headings —

Click anywhere
within the line
item to

select it.

E Select Invoices for Payment

1 Vend D/I? No.
01-ARWAY

1 D1-ARWAY
01-COMPAQ
01-CONT
02-AMEX
02-CORPEIS
02-EMPLOY

‘Vendor Name
Airway Property
Airway Property

Compag Computer Corpo...
Container Corporation Of...
American Express Comp...
Corporate Enterprise Infr...

Employment Developmen...

Invoice Mo
0000108020
0000106145
4350951485820543
444567

MAYSTMT
98342857
33-65667

Invoice Date
5/M15/2020
572020
5/30/2020
50172020
5172020
5/29/2020
5i1/2020

Due Date

513012020
513012020
513012020
513012020
513012020
513012020
5/30/2020

Total Selected

- [m] >

Disc. Date Past Disc.

5]

>

o

You can use the UP ARROW and DOWN ARROW keys to select line items. To

select more than one line item, press the CTRL key and click the items. To select a
range of items, press the SHIFT key, click the first item, and then click the last item in
the range.

Using the Lookup Feature

Q) When entering data in a maintenance or data entry window, you can click the
Lookup button at certain fields to display a list of records. You can then select the
appropriate record. The Lookup feature contains options that allow you to filter and

é NoTE customize the search criteria, and create up to 99 custom lookup views. In addition,

The title of the
lookup window
reflects the name
of the field at
which you clicked

you can print the list of records appearing in the lookup list box. The illustration
below shows a lookup window.

To learn basic features of the Lookup, See Using the Lookup's Basic Features on

the Lookup page 48. For instructions on how to use advanced features of the Lookup, See
button. Using the Lookup's Advanced Features on page 51.

Getting Started Guide
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Click a column
heading to sort the
list by that criteria.
An arrow next to
the heading
indicates the
current sort order.

If filters are already
defined, the texton
this button is red.

After the search

is complete, the
record count
appears in the
Status Bar.

| Click this button to
drill down to
Customer, Vendor,
or ltem Inquiry.
This button is
available only in
the Customer, Item,
or Vendor lookup
window.

For some lookups,
press the F3 and
F4 keys to toggle

between the key
field and the Name

E Vendor List - m} X
- 1
=
Vendor No Name Status Zip Code Phone Number @ %_
01-AIRWAY Airway Property Active 92669-0001 (714) 555-0980
01-ALLCLIM Aliclimate Maintenance Active 82626 (714) 555-1013
01-ANDERS Anders Auto Repair Active 92969 (714) 555-3030
01-COMPAT Compaq Computer Corporation Active 92626 (714) 555-5921
01-CONT Container Corporation Of Usa Active 65436 (312) 555-7721
01-1BM Ibm Corporation Active 82775 (415) 555-9981
O1-INACTM Johnston Postal Supplies *INACT... Inactive 92504 (949) 5551927
01-POSTMST  U.5. Postmaster Active 82626 (714) 555-7659
01-SOCALGA  Southern California Gas Co. Active 9177 (714) 555-0098
01-STEV Stevens Supply Active 95052 (408) 5556781
01-SWAM Southwest Amalgamated Distribu. .. Active 82650 (948) 452-0001
01-UNITED United Computers Active 75285
01-UPS United Post Office Service Active 82711 v
T = e —— o — =
I
Search | Wendor No - | | Begins with - | | Find
— 1 Fiters... View |Standard -
r
Custom... Lookup Wizard... IT( é @
TFound 33 records

field.

This field appears only if you
defined one or more custom
lookup views. The Standard

view is generated by the

Click this button to
export data in the lookup
window to Excel.

software.

If you click Print while
the Lookup list box is still
loading, only the data
that has loaded prints on

E Lookup Vendor List

LOOKUPVENDOR LIST

the listing.

-+~ What if you clicked the Lookup button and no records appear in the lookup

-

window? This occurs because:

User Maintenance.

information, see User Lookup Wizard in the Help system.

A custom filter that has no result set is in effect.

The number of records is over the limit set at the Lookup Limit for Initial Display field in

The Initial Display check box on the fifth User Lookup Wizard page is cleared. For more

To display records, filter the information by using the Search, Operand, and Value fields,
and then click Find.

Navigating with Common Buttons, Icons, and Keystrokes

All maintenance and data entry windows share the same set of buttons and
keystrokes to help you navigate through data and perform common tasks. If you
prefer to use the keyboard while you work, most buttons have keyboard equivalents.

For a list of common buttons and their keyboard shortcuts, see the Keyboard and
Button Navigation article in the Sage 100 help.

Getting Started Guide
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Getting Help While You Work

Several sources of information are available to you in the software. Use the following
resources to find answers to your questions as you work.

Help System - Common Procedures
Quickly find procedures and answers for your
"how do I" questions by clicking the Help
button on any screen or on the Help tab on the
Sage 100 Desktop.

Help System - FAQs & Troubleshooting
Find answers to frequently asked questions
and view troubleshooting information.

Using the Help System

Use the Help system when you want procedures for day-to-day processing, detailed
information and entry samples for fields, and FAQ and troubleshooting information.
Overview information and flowcharts illustrating complex concepts are also available
in Help. If you do not find what you need, access information from the additional
resources provided on the Help menu.

Accessing Help

Create a Reversing Journal Entry

Home | FAQs & Troubleshooting

Show/Hide All

Qverview

To create a reversing journal entry

. Select General Ledger Main menu > General Journal Entry.

~

. In the Source Journal field, enter a source journal code. For
more information, see General Journal Entry - Fields.

w

. In the Entry Number field, enter the number that identifies
this journal

=

. Enter the posting date and reversing date

o

. Click the Lines tab, and enter debit and credit account
information. Click Accept

FAQs & Troubleshooting

*View All Subcategories
Click a link below to view FAQs and troubleshooting information for
that category.

+ Sage 100 Desktop and ' Job Cost
User Interface

v Accounting Dates and * Journals and Registers
Periods
Budgets Paperess Office

'
Business Insights ' Payroll
Business Objects Interface * Posting and Updates
Checks * Printing
)
’

E

Credit Card Transactions Purchase Orders

Customer Relationship
Management
eBusiness Manager ' Retum Merchandise

Reports and Forms

You can access Help using any of the following methods:

From the Desktop, on the Help tab, click Help Topics.

Press F1 at any field in the software to access Help for that field.
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E =

® * =

Help Topics  What's
Mew

Documentation
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Web Content Modules Favorites View Hel

e In the bottom-right corner of any window, click the Help button. Help for the
specific window appears.

e If you click the Help button and the window has corresponding How Do |
procedures, a drop-down list of procedures appears. The following illustration
shows the Help button clicked in the Vendor Maintenance window.

Copy Vendor Information Procedures commonly
Add 1099 Payments to Vendor History performed in this window
FEix Vendor Purchase and Payment History |_appear on this list. Click a
Renumber a Vendor procedure to view it.

Enter a Remit-to Address

Click here to view overview
information for the window.

About this Window

When you access the Sage 100 help, you'll be taken to the online help site if an
internet connection is detected. If you don’t have an internet connection, you'll see
the locally installed help instead.

Customer Support

There are several resources you can use for technical assistance before contacting
your Sage business partner or Customer Support:

e Refer to the software's Help system.
e Search for answers in the Sage Knowledgebase at: https://support.na.sage.com

e Visit the Sage 100 online community at:
https://sagecity.na.sage.com/support_communities/sage100_erp

e To access file layout and program information, click the File Layouts and
Program Information link on the Desktop's Resources page.

After using the above options, if you require more assistance, you can start a live
chat session with Sage Customer Support or enter a support ticket by selecting an
option on the Help tab.

Sage 100

=]

B O L o ¢ © a8 b

Tour the Product Knowledgebase Downloads  Live Chat Enter a Remote Support Online Sage University
Desktop  Documents and Updates Support Ticket Session Community
Suppert
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é NoOTE

The Material
Requirements
Planning and
Work Order
modules are not
available for
Sage 100
Premium.

Getting Started Guide

Learning Common Procedures

Whether you are new to Sage 100, or an experienced user who wants to review
basic and advanced concepts, this chapter gives you hands-on practice with
common procedures. Some lessons apply only to the standard Desktop and some to
the classic Desktop; they are organized accordingly.

Lessons
This chapter contains the following lessons:

Creating a Company on page 44

Creating a User on page 45

Changing a User Password on page 46

Changing User Settings on page 46

Changing the Accounting Date on page 46

Changing the Module on page 47

Opening a Task in a Secondary Company on page 47
Using the Lookup's Basic Features on page 48

Using the Lookup's Advanced Features on page 51
Printing Reports, Listings, or Forms on page 59
Creating a Report Setting on page 67

Setting Up Sage Intelligence Reporting on page 68
Understanding How Sales Tax is Calculated on page 78

Changing Sales Tax Information on page 86
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Creating a Company

Many systems are set up with multiple companies to keep financial records for
individual companies separate, and to separate real company data from test
company data. Each company is identified by a unique, three-character company
code. You can process information for a specific company by selecting the
appropriate company code.

To create a company
1 Select Library Master Main menu > Company Maintenance.

2 Enter a company code and company name.

E] company Maintenance (ABC) 1/5/2018 — O bt
Company Code  |28C |k 14 4 B B Activate..  Convert...

Company Name  |ABC Distribution and Service Corp. e Copy...

1. Main 2. Preferences 3. Payment 4. E-mail 5. Fax &. Theme

Company Information

Address 7595 Irvine Center Drive Telephone (949) 5551247
Suite 200 Fax (949) 555-3457
Irvine, CA 92513 Federal ID Mo.
State ID No.
URL Address &
E-mail Address ]
Trade Name

Activated Modules

Module Data Level &2
Accounts Payable 6.10
Accounts Receivable 6.10
Bank Reconciliation .10
Common Information 6.10
General Ledger 6.10
Inventory Management 6.10
eBusiness Manager 6.10
Purchase Order 6.10 o

w Accept Cancel 5 0 .

3 Enter information in the fields appropriate to your company, including the federal
ID number.

4 Click Activate to activate one or more modules.

5 When prompted to save the new company, click Yes.
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6 When the Activate Module window appears, select the module(s) to activate
and click Proceed.

7 In Company Maintenance, verify that the modules you selected appear in the
Activated Modules area of the window and click Accept.

Creating a User
You must enter a valid user logon and type a password, if applicable, before you can
access the software.

To create a user
1 Select Library Master Main menu > User Maintenance.

2 Enter the user logon, first and last name, and user code.

&} user Maintenance (ABC) 1/5/2018 — O >
User Logon |jwsmith |Q\J 4 4 B B Copy. Rename
First Mame |[John Last Name |Smith | User Code [JWS
Paszword |esssssss Confirm Password [sessssss | Customization Group | | Expires |:
E-mail john.smith@=sample.sage.com || Job Title | Admin Assistant/Office Manager -

1. Maintenance 2. Preferences 2 Auto-Complete

Company Role Start Date Expiration Date :}IC
- All Companies Supervisor - %
2 -

G e—— &0

If the Use Unified Logon check box is selected in System Configuration, the
user logon must match the user’s Windows logon key field.

3 Type a password.

A password is required if the Require all Users to Enter a Password check box is
selected in System Configuration.

4 On the Maintenance tab, select the company and role to assign to the user.
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Changing a User Password

On the Preferences tab, select user-specific preferences.

If the Auto-complete feature is enabled in System Configuration, change the
default options on the Auto-Complete tab as needed.

Click Accept.

Changing a User Password
User passwords can be changed for any user currently logged onto the system.

To change a user password

1

2

Select File menu > Change User Password.

In the Old Password field, type the current password for the user.

In the New Password field, type the new password for the user.

In the Confirm Password field, type the same password that was typed in the
New Password field.

Click OK.

Changing User Settings

The User Settings window allows you to specify default options, such as the default
zoom level when viewing reports.

To change user settings

1

Use any of the following methods to open the User Settings window.

o

o

Select File menu > Change User Settings.

When using the Standard Desktop, on the Home tab, click Change User
Settings.

When using the Classic Desktop, on the Standard Buttons toolbar, click the
Change User Settings button.

Make changes as needed.

Click Accept.

Changing the Accounting Date

The accounting date is printed on all reports, and represents the date to be used
while posting transactions for the current module. The Library Master accounting
date is set from the Windows system date and cannot be changed.

Getting Started Guide
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Changing the Module

& NOTE

The M/dlyyyy
format is the
default date
display format.
The format of the
accounting date
is set from the
Windows Control
Panel.

é NoTE

Modules
automatically
change when you
select a task from
another module
using the Module
Menus toolbar,
Tree View, or
Modules menu.

é NoTE

To define a new
secondary
company without
opening a task,
select Change
Secondary
Company from
the right-click
menu.

Getting Started Guide

To change the accounting date

1 Use any of the following methods to change the accounting date from the
Desktop:

o Select File menu > Change Date.
o On the Status Bar, click in the accounting date area.
2 Enter the accounting date.

3 Click OK. The accounting date appears on the Status Bar.

Changing the Module

The active module always displays on the Status Bar.

To change the module
1 Use either of the following methods to change the module from the Desktop:
o On the Status Bar, click the module.

o When using the standard Desktop, on the Modules tab, click Change Current
Module.

o When using the classic Desktop, select Modules menu > Switch To.

2 Select a module.

3 Click OK. The new module displays on the Status Bar and the module menus
change to reflect the specified module.

Opening a Task in a Secondary Company

From the Desktop, you can open a task in a secondary company without changing
the current company displayed on the Desktop Status Bar. You can define any
company as the secondary company.

To open a task in a secondary company

1 In the Desktop's task pane (for the standard Desktop) or Tree View (for the
classic Desktop), right-click a task and select one of the following options:

o Open in New Secondary Company: Select this option to define a new
secondary company and to open the task in that secondary company, and
then proceed to step 2.

Page 47



Using the Lookup's Basic Features

o Open in Secondary Company (ABC): Select this option to open the task in
the currently defined secondary company. In this example, the secondary
company defined is ABC, and the task opens in company ABC. You are

finished.

2 Select the company to open the task in.

3 Click OK. The task opens in the selected secondary company.

Using the Lookup's Basic Features

When entering data in certain fields in a maintenance or data entry window, you can

click the Lookup button to display a list of valid records. Th
procedures on how to use the Lookup feature. To learn mo
See Using the Lookup's Advanced Features on page 51.

Using the Lookup to Select a Record

is lesson contains basic
re advanced features,

Use the Lookup feature to display a list of records and select the appropriate record.

To select a record using the lookup window

1
available records.

In a window, click a Lookup button. The lookup window appears displaying the

E] customer List — O >
~
Customer No Name Status Zip Code Phone Mumber Sort ™ %
01-ABF American Business Futures Active 53205-1204 (414) 5554787 AMH
01-ABS ABS - Sage cloud for invoices  Active 92860 (949) 555-7314 AME
01-AWNET Axvnet Processing Corp Active 53120 (414) 555-2635 AW
01-BRESLIN Breslin Parts Supply Active 53266 (414) 555-9654 BRE
01-HILLSEB Hillsboro Service Center Active 33191 (414) 5556599 HILL
01-INACTIV Inactive Customer =INACTNE®  Inactive 53205-1204 (414) 5558747  INA(
01-MANRK Maverick Papers Active 60601 (312) 861-1200
01-RSSUPPL R &S Supply Corp. Active 53126 (414) 555-5587 R&S
01-SHEPARD Shepard Motorworks Active 53151 (414) 5555544 SHE
02-ALLENAP  Allen's Appliance Repair Active 92875 (714) 555-3121 ALL
02-AMERCON  American Concrete Service Active 92825 (714) 555-2134 AME
02-ATOZ ATo Z Carpet Supply Active 92661 (714) 555-2231 ATO
02-AUTOCR Autocraft Accessories Active 92861-0002 (714) 5550101 AUT ,
,.(.,n.,m..,.., T - .. mmmrm s reace mee omaes H.},
Search | Customer Mo ~ | | Begins with - | | Eind
Fiters...
Custom... Lookup Wizard... Select IT'( % O
Found 19 records

2 In the lookup window, select a record from the list box

record is then selected in the original window.

Getting Started Guide

and click Select. The
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Searching in the Lookup

The lookup window provides a Search field and a Find button to narrow your search
for desired records. This feature is a convenient way to reduce the number of
records displayed and helps you to focus on pertinent records.

To search in the lookup window
1 In the lookup window, in the Search field, select the field to search.

2 In the Operand field, select an operand. For information about available
operands, see Filter the Lookup Criteria in the Help system.

3 In the Value field, type a search value for the lookup.

4 Click Find to execute the search. The lookup list box displays the search results.
In this example, the lookup searches and returns all customer numbers that

begin with 01.
E Customer List — O >
s
Customer No Name Status Zip Code Phone Mumber Sort Fie {‘%
American Business Futures 53205-1204 (414) 555-4T87 AMER
01-ABS ABS - Sage cloud for invoices  Active 92680 {(949) 555-7814 AMER
01-AWNET Avnet Processing Corp Active 53120 {414) 555-7635 AMNET
01-BRESLIN Breslin Parts Supply Active 53766 {414) 555-09554 BRESLI
01-HILLEB Hilleboro Service Center Active 53151 {414) 5555599 HILLSE
01-INACTIV Inactive Customer *sINACTNWVE® Inactive 532051204 (414) 5558747 INACT
01-MAVRK Waverick Papers Active 80801 (312) 881-1200
01-RSSUPPL R &S Supply Corp. Active 53126 (414) 555-5587  R&SSUI
01-SHEPARD Shepard Motorworks Active 531581 (414) 5555544 SHEPAF
£ >
Forinstructions on
this button, See
Filtering the Search | Customer No « | | Begins with - |D1 | Find
Lookup Criteriaon ——  gjare
page 50. .
Custom... Lookup Wizard... Q g 0
Found 9 records

L Operand field L Value field

5 Select an item from the list box and click Select. The selected record is copied
to the field.
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Filtering the Lookup Criteria

In any lookup window you can define additional criteria to filter the lookup and you
can save these filters so that they apply to future lookups until they are manually
removed. Filtering the lookup criteria helps you narrow your search on desired fields.

- %~ There are two differences between filtering the lookup criteria and searching in the

-

lookup. When filtering, you can define an unlimited number of filters on multiple
lookup fields, and you can save these filters so that they always apply to the

lookup. In contrast, when you perform a search in the lookup window, you can search on
only one lookup field, and the search criteria cannot be saved.

é NoTE

Filters that are
defined in the
User Lookup
Wizard and
Lookup
Customization
Wizard also
appear in this
window. If the
filter is locked, it
cannot be
changed. If the
filter is not
locked, it can be
removed or
modified.

é NoTE

If the Save Filters
check box is
cleared, the filters
remain in the
Filters window
and remain in
effect during the
lookup; however,
when you exit the
lookup, these
filters are
removed.
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To filter the lookup criteria

1

In the lookup window, click Filters. In the Filters window, each line item is a filter
consisting of a Column, Operand, and Value.

= Fitters - O >
Column Operand Value
1 i bl < =
2 - -
Save ]
BTN ©

In the Column field, select the lookup column you want to filter. The Column field
reflects all of the columns defined for the lookup.

In the Operand field, select the appropriate operand. For information about
available operands, see Filter the Lookup Criteria in the Help system.

In the Value field, type a value. If you enter multiple values separated by
commas (,), the system assumes an "OR" condition.

To add additional filters, repeat steps 2 through 4. You can define an unlimited
number of filters; multiple filters assume an "AND" condition.

To retain these filters for future lookups, select the Save Filters check box.

Page 50



Using the Lookup's Advanced Features

é NoTE

If another user is
in the User
Lookup Wizard
and is creating or
modifying a
lookup code
while you attempt
to create or
modify a lookup
view, a message
appears and
prevents you
both from
continuing.
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7 Click OK to apply the filters. In this example, the lookup returns all customers
beginning with 01 and ZIP Codes beginning with 5.

] custorner List - O it
s
Customer No Name Status Zip Code Phone Number Sort Fie %
American Business Futures 53205-1204 (414) 555-4787 AMER
01-AWNET Avnet Processing Corp Active 53120 (414) 555-2635 AWVNET
01-BRESLIN Breslin Parts Supply Active 53266 (414) 555-9654 BRESLI
01-HILLSB Hillsboro Service Center Active 53151 (414) 5555599 HILLSE
01-INACTIV Inactive Customer =INACTIVE®™ Inactive 532051204 (414) 5558747  INACT
01-RSSUPPL R & S Supply Corp. Active 53126 (414) 5555587 RE&SSUI
01-SHEPARD Shepard Motorworks Active 53151 (414) 5555544 SHEPAF
< >
Search | Customer Mo ~ | | Begins with - | | Find
Filters...
Custom... Lookup Wizard... Select Q % G
Found 7 records

Deleting Filters

You can delete filters after they have been defined.

To delete and reset filters
1 In the lookup window, click Filters.
2 To delete afilter, in the Filters window, select <none> in the filter's Column field.

3 To delete all filters, click Reset. The filters are cleared, and any filters from the
custom lookup, if one exists, are restored.

4 Click OK.

Using the Lookup's Advanced Features

The Lookup has advanced features that allow you to create lookup views, create a
numeric lookup field, modify a lookup field, and export lookup data to Excel. If you
are new to the lookup, complete Using the Lookup's Basic Features on page 48
before starting these procedures.
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é NoTE

The Custom
button is not
available if the
Locked
Customization
check box is
selected in the
User Lookup
Wizard.

é NoTE

The first column
indicated by an
asterisk (*) in the
Selected
Columns list box
cannot be
removed;
however, it can
be modified. For
instructions, See
Modifying a
Lookup Field on
page 57.
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Creating a Lookup View

For each lookup by company and by user, you can create up to 99 unique views.
When creating a lookup view, you can define your default view, add, remove, or
modify fields in the lookup, add or remove filters, as well as define several other
settings. After creating a lookup view, you can modify or delete the view at any time.
Keep in mind that any search criteria or filters you previously defined will not apply to
the new lookup view you create.

To create a lookup view

1

2

In the lookup window, click Custom.

On the Lookup Customization Wizard page, in the View field, select Create new
view and enter a description for the new view. Alternately, select an existing view
to modify.

To set the new lookup view as the default view, select the Default View check
box. Click Next.

=] Lookup Customization Wizard ? *

Select view parameters for Lookup - AP Vendor Master List

sage
Company ABC, User A8 g

Wiew Create new view -

Diescription |Basic

TN .

In the second Lookup Customization Wizard page, add, remove, modify, or
reorganize the fields for the lookup view in the Selected Columns list box. In this
example, the TelephoneExt and LastPurchaseDate fields have been added to
the Selected Columns list box, and the ZIP Code field has been moved to the
Available Fields list box.
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For more information
about this button, see —
Creating a Numeric
Lookup Field on
page 55.

E Lookup Customization Wizard

Select or modify the column(s) for Lookup - AP Vendor Master List

Company ABC, User AB View - Basic

Available Fields

Selected Columns

sage

- Zip Code L] » *Vendor No
- Status
Name
- APDivisionNo [ ]
- Vendoro Phone Number
. AddressLine TelephoneExt
- AddressLine? 4 Sort Field
----A_ddressLineS 44 |LestPurchaselate
- State
- CountryCode
.- PrimaryContact For more
Fax;jm v information
S— - about this
New Field... = i Wodf —— button, see
Modifying a
| <gack Lookup Flold
on page 57.

é NOTE

For a review on
how to create
filters, See
Filtering the
Lookup Criteria on
page 50.
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5 Click Next to define additional settings, or click Finish if you have completed

customizing the view.

6 Use the third Lookup Customization Wizard page to add, delete, or modify
filters. To continue defining additional settings, click Next; otherwise, click

Finish.

1
2

-l -l

j Begins with j 02

E Lookup Customization Wizard ? X
Enter or modify the fiter(z) for Lookup - AP Vendor Master List
_ _ sage
Company ABC, User AB View - Basic
Column | Operand | Value |
Vendor No

BTN I IECH BT
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7 In the final Lookup Customization Wizard page, make any final changes to the
lookup view.

o Select the Initial Display check box to load data in the lookup at run time. If
you do not want data initially loaded in the lookup at run time because you
have a large number of records and want to perform a search before
displaying records, clear this check box.

o In the Title field, type a new title that will display in the lookup window title
bar.

o In the Default Search Column field, select a default field to appear in the
Search field in the lookup window.

o In the Default Search Option field, select a default field to appear in the
Operand field in the lookup window.

=] Lookup Custornization Wizard ? X
Select other parameters for Lookup - AP Vendor Master List
sage
Company ABC, User AB View - Basic g
Initial Display
Title |Vendor List - Basic
Default Search Column | LastPurchaseDate -

Default Search Option | Begins with -

8 Click Finish to see your newly created lookup view.

The View field appears in the lookup window and the new view, Basic, displays
the newly added fields. In the example below, the new fields are TelephoneExt
and LastPurchaseDate, while the deleted ZIP Code field no longer appears.
Also, the title bar displays Vendor List - Basic because this title was defined in
the Title field in the last page of the wizard and was set as the default view.
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An asterisk (*) appears
in the title bar to indicate
that this is a custom
view, not the Standard
view generated by the
software.

The asterisk (*) next

to the new view
indicates that this is
the default view.

= = vendor List - Basic — O *
.
“endor No Name Phone Number TelephoneExt Sort Field ™ I"‘i
02-AIRTRAN Airport Service Travel AIRPORT
02-AMERALR  American Alarm Service (617) 555-5561 AMERICAN,
02-AMEX American Exprezs Company (800) 555-66T5 66T AMEX
02-ARROW Arrowsmith Drinking Water (213) 555-5541 ARROWSM
02-AVID Avid Label (213) 555-7693 AVID
02-BROWN Brown & Johnson (213) 5558321 BROWHN
02-CONSULT Tax Consultants, Inc.
02-CORPEIS Corporate Enterprise Infrastructu... (949) 38931234 CORPEIS
0Z2-DNARCH Diversified Architectural Concret...  (714) 876-3241 DMVARCH
02-EMPLOY Employment Development Dept EMPLOYDE
D2-EQUAL State Board Of Equalization STATE
02-IRS Internal Revenue Service (408) 555-1234 9821 IRS
0Z-LEARNER Roger W. Learner (714) 555-1478 00s8 LEARMER ,
£ >
Search || astPurchaseDate - | |Begin5 with - | | | Find
Filters. .. Wiew I*F_lasic - |
I
Custom... Lookup Wizard... Q 5 o
|F1:|un1:| 20 records | | |
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Creating a Numeric Lookup Field

You can create numeric fields to add to the Selected Columns list box in the second
Lookup Customization Wizard page. Numeric fields are created by combining two or
more fields together using arithmetic operators.

To create a numeric lookup field

1 In the second Lookup Customization Wizard page, click New Field to create a
new numeric field using simple arithmetic functions.

type the name for the column/field.

3 Type the width and select the justification.

In the Lookup Customization Wizard - New Field window, in the Heading field,
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4 Type the mask.

] Lookup Customization W...  — it

Heading |¢new field= |
Justification

Mask |m,###,###,##u.ou- |

Calculated field | |1’T

NN o

5 Click the Calculated Field button to enter simple arithmetic calculations.

6 In the Calculated Field Builder window, double-click a field in the Available
Fields list. This moves the field to the expression area. Select an operator,
choose another field from the list, and click OK.

] calculated Field Builder - O X

AveragelaysOverDus-AveragelDaysToPay

Available Fields
- LastCheckamt ~
RetentionRate
AverageDaysToPay
AverageDaysOverDue
j Balancelue
NumberOfinvTolselnCalc
[ AP TermsCode w7

ce TN o

7 In the Lookup Customization Wizard - New Field window, click OK. The newly
created field automatically appears as a column in the Selected Columns list
box.
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Modifying a Lookup Field

1 In the second Lookup Customization Wizard page, click Modify to alter the

selected field in the Selected Columns list box.

2 In the Lookup Customization Wizard - Modify window, make the desired

changes and click OK. For example, you can change the width of the key field to

zero if you do not want to display it in the lookup.

E Lookup Customization W... —

Heading |S|:|rt Field
Width |15
Justification Left -
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Exporting Lookup Data to Microsoft Excel

You can export the data displayed in a lookup window to Excel if you hae the
appropriate security setup. You can also select a customized lookup view or perform
a search in the lookup window to display specific records, and then export the data

to Excel.

To export lookup data to Excel

1 In the lookup window, display the data to export to Excel.

= = vendor List - Basic — O *
.
“endor No Name Phone Number TelephoneExt Sort Field * ﬂ
02-AIRTRAV Airport Service Travel AIRPORT
02-AMERALR  American Alarm Service (617) 555-5561 AMERICAMN,
02-AMEX American Express Company (800) 555-66T75 6675 AMEX
02-ARROW Arrow zmith Drinking Water (213) 555-5541 ARROWSM
02-AVID Avid Label (213) 555-7693 ANID
02-BROWN Brown & Johnson (213) 555-8321 BROWHN
02-CONSULT Tax Consultants, Inc.
02-CORPEIS Corporate Enterprize Infrastructu... (949) 393-1234 CORPEIS
02-DNARCH Diversified Architectural Concret... (714) 876-3241 DMARCH
02-EMPLOY Employment Development Dept EMPLOYDE
02-EQUAL State Board Of Equalization STATE
02-IRS Internal Revenue Service (408) 555-1234 9821 IRS.
0Z2-LEARNER Roger W. Learner (714) 555-1478 0098 LEARNER ,
n(, A e s P s o, s
Search | LastPurchaseDate - | |Begin5 with - | | | Find
Filters... Vigw |‘Basic v|
Custom... Lookup Wizard... Q 5 9
|F1:|un1:| 20 records | | |

Excel button

2 Click the Excel button. The data in the lookup window is exported to Excel.
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é NoTE

Click Preview to
review the listing
before printing.

Getting Started Guide

Printing Reports, Listings, or Forms

All reports can be printed, exported or written to a file, and stored for deferred
printing. You can print a report to a variety of printers or output devices. Additionally,
reports can be viewed before printing using the Preview feature.

Printing a Report, Listing, or Form

To print a listing in modules other than Material Requirements Planning and
Work Order

1

In the task window that has the Listing feature available (for example, General
Ledger Options), make the needed selections to the criteria in the window and
click Print.

In the listing window that appears, in the Printer field located in the lower-left
corner of the window, select the printer.

You can also select alternative printing methods, which are available in the
Printer field, including:

o

Export/E-mail: Reports can be exported to different file types, such as PDF
or Excel, and saved to your hard drive or e-mailed. For more information,
See Exporting or Printing to a File on page 64.

Data Only Export: This option allows only the data portion of the report to be
exported (header information is excluded). For more information, See
Exporting or Printing to a File on page 64.

Deferred: Report printing can be deferred allowing you to save reports on
your hard drive for printing at a future time. For more information, See Using
Deferred Printing on page 61.

Office Merge: If the Custom Office module is installed, you can merge your
data into a template such as a Microsoft Word or Excel template before
printing.

Click Print to print the listing.
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& N To print a report or form
OTE
The standard set 1 In the report or form window, select either a report setting or a form code.
of reports and
forms are
assigned a report E Budget and History Report (ABC) 5/31/2020 - O X
setting of
Standard. Report Setting STANDARD |ck Save -
Description Budget and History Report |
Setting Options
Type Public - Print Report Settings |:| Number of Copies C
Default Report Three Hole Punch ] v
Sort Report By | Account Number -
Options
Print Zero Balance Accounts | Yes -
Print Totals Only O
Information to Print ActualBudget Fiscal Year | ~ 5@
ACTUAL POSTINGS &, | 2020
ORIGINAL 2020
ACTUAL POSTINGS 2018 v
Selections
Select Field Operand Value -~
Account Number All -
Description All -
WMain All -
Department All -
1 i an =
Keep Window Open After
Adobe PDF T Printl:| |:| Presiew |:| mm O

2 You can either accept the default settings for the current report setting or form
code, or create a new report setting or form code. For more information, See
Creating a Report Setting on page 67.

& NoTe 3 In the Printer field located in the lower-left corner of the window, select the
You do not need printer.

to save the report

sefting or form You can also select alternative printing methods, which are available in the

code setting to
print the report or
form.

Printer field, including:

o Export/E-mail: Reports can be exported to different file types, such as PDF
or Excel, and saved to your hard drive or e-mailed. For more information,
See Exporting or Printing to a File on page 64.

o Data Only Export: This option allows only the data portion of the report to be
exported (header information is excluded). For more information, See
Exporting or Printing to a File on page 64.
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é NoTE

Click Preview to
review the report
before printing.
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o Deferred: Report printing can be deferred allowing you to save reports on
your hard drive for printing at a future time. For more information, See Using
Deferred Printing on page 61.

o Office Merge: If the Custom Office module is installed, you can merge your
data into a template such as a Microsoft Word or Excel template before
printing.

After selecting or modifying the report setting or form code, click Print to print the
report or form.

Using Deferred Printing

Deferred printing allows you to save reports on your hard drive for printing at a future
time. You can batch print multiple reports at one time without operator intervention
between reports. You can also specify the number of copies to print for each report,
as well as whether to retain the deferred report information for future use after
printing. In a multi-user environment, this feature can postpone the report printing
process if printers are not currently available, or it can speed up the posting process.

Deferring a Report

You must first set up reports to be deferred for future printing.

To defer the printing of a report

1 Access the report to defer (for example, the Budget and History Report in the
General Ledger module) and select the report options.

2 In the Printer field, select Deferred and click Print.In the Deferred Print Options
dialog box, in the Number of Copies field, type the number of copies to print.

E Budget and History Report ? >
Deferred Print Options

Erintar Laser Printer -

Number of Copies 1 : 7

Purge After Printing
Secure Report |:|

EENEEE o

3 Select or clear the Purge After Printing check box to either purge or retain the
report after printing. Select the Secure Report check box to restrict other users
from printing the report.

4 Click OK. The report generates to a deferred print file, which can be accessed
and printed at a later time.
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Printing Deferred Reports
You can print one page of a deferred report or a range of pages. In addition, you can

print several copies of a report and more than one report at a time. If a report is
secured, only the user who initially deferred the report can print it.

To print deferred reports

1 To access and print deferred reports from the Sage 100 Desktop, use either of
the following methods:

paL) o Click the Deferred Print button on the Standard Buttons toolbar.

o Select File > Deferred Printing.

& NoTE 2 In the Deferred Printing window, select the report(s) to print.
Click the Change
View button to o To print all deferred reports, select the Module check box.

view reports in
the Deferred
Printing window
sorted by
module, user, or
date. Initially, the ) o
reports are sorted o To print only selected reports, select each report check box individually.

by module.

o To print deferred reports for a specific module, select the module's check
box. For example, select the General Ledger check box to print all deferred
reports in the General Ledger module.

=] Deferred Printing — O >

{4 Select the deferred reports to print, then click Print.

E Module Te — Change View
= O Accounts Receivable (@ — Refresh Report List
[0 Cash Expectation Report / jwsmith - 2018 January & - 05:33:13pm

= & General Ledger E9 —+ Preview Report

%] Budget and History Report / jwsmith - 2018 January & - 05:32:24pm o — Show/Modify Report

Options
L— Delete Report

e | conce 0
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3 To preview a report, select the report and click the Preview Report button.

4 To export the report to a different file type, click the Export Report button in the
report preview window.

5 To change printing options for a specific report, select the report and click the
Show/Modify Report Options button.

6 In the Deferred Report Options window, change the information in the Printer,
Number of Copies, Collated, Purge After Printing, Secure Report, and Page
Range fields. Click OK.

5] Deferred Report Options ? *
Report Information
Report Title Budget and History Report
Module General Ledger
User jwesmith
Company ABC
Date Created 2018 January 8 05:32:24pm

Deferred Print Options.

Printer Laser Printer -

Number of Copies 1 :

Purge After Printing

Secure Report |:|
Page Range @ AllPages ( Total Report Pages @ 70 )
Page From O 1 To 70

7 In the Deferred Printing window, click Print to print the selected reports to their
assigned printers.
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Exporting or Printing to a File

Reports can be exported to other files types, such as CSV, Excel, or PDF, and they
can be saved to your hard drive or e-mailed. You can also export only the data
portion of reports (header information is excluded).

To export a report

1

2

Access the report to export and select the report options.
In the Printer field, select one of the following options:
o Export: Select this option to export the entire report.

o Data Only Export: Select this option to export only the data portion of the
report (header information is excluded).

Click Print.
In the Export dialog box, in the Format field, select the file type for exporting.
In the Destination field, select the location you are exporting to. For example,

you can export the report to your hard drive or to an application such as Excel.
Click OK.

Sending Faxes

To send a fax from the software, a fax driver must be loaded in the Windows
workstation environment. The fax driver acts as a printer driver in the software.

To send a fax

1
2

Getting Started Guide

Access the report and set the report options.

In the Printer field, select the fax driver.

Click Preview.

In the report preview window, click the Print Report button.
In the Print window, click OK.

A wizard or window applicable to your fax software appears. Enter the
necessary information, such as the recipient’s fax number, and send the fax.
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& NoTE

When printing
picking sheets,
packing lists,
Sales Order
invoices, sales
orders, Accounts
Payable checks,
Accounts
Payable
extended stubs,
1099 forms,
Accounts
Receivable
invoices,
purchase orders,
receivers, RMAs,
or Accounts
Receivable
statements,
select the form
code for printing
to a dot-matrix
printer. For more
information, see
Creating a Report
Setting on

page 67.
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Paperless Office

You can use the Paperless Office module to fax, e-mail, and store forms in PDF
format. The Paperless Office module allows you to set up PDF storage and
electronic delivery options for documents in all Sage 100 companies. You can
specify separate settings for journals and registers, reports, period-end reports, and
forms.

This module also contains viewers in which you can view, move, delete, and
electronically deliver PDFs of customer forms, vendor forms, journals and registers,
standard reports, and period-end reports.

Purge utilities are also included which allow you to purge PDF documents as
needed.

You do not need to enable this module in Company Maintenance; however, you
must enable Paperless Office functionality for each type of document you would like
to store and electronically deliver. For more information, see Set Up Paperless Office
in the Help system.

Batch Faxing

Batch faxing allows you to fax multiple forms in batches. During the faxing process,
forms addressed to the same fax number are collected and sent as a group with one
cover letter. Batch faxing is set up using Batch Fax Options or Fax Form Definition,
and requires either the Microsoft Fax Services or WinFax 10 fax driver.

Forms printed using the following tasks are supported for batch faxing: Statement
Printing, Accounts Receivable Invoice Printing, Customer RMA Printing, RMA
Receiver Printing, Sales Order Printing, Picking Sheet Printing, Sales Order Invoice
Printing, and Purchase Order Printing. For more information, see Fax Multiple Forms
in Batches in the Help system.

Setting Printing Preferences for Dot-Matrix Printers

To achieve optimum printing speed for dot-matrix printers, native fonts can be
selected through the Windows driver to increase print speed.

Some printer drivers may only have the Default selection available for the font. If this
is the case, you must download an updated driver for your printer from the printer
manufacturer's Web site or select another compatible driver emulation (refer to your
printer manual or consult a printer manufacturer for details). Each printer has unique
font options available. Most native font selections will print faster than the Default
font selection.

To set printer preferences for dot-matrix printers
1 Select Library Master Setup menu > Printer Preferences.

2 In the Printer Preferences window, select the dot-matrix printer from the printer
list.
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3 Clear the Enable Graphics Printing for this Printer check box. This setting is
specific to the printer and overrides the global setting.

4 Select the Show Native Printer Fonts Only check box. This is a temporary filter
and must be selected each time you access this window to change a font.

5 In the Normal Font Name field, select 10 CPI Draft, 10 CPI Courier (not Courier
New), or any font other than Default.

6 In the Normal Font Size field (to match the font selected in the Normal Font
Name field), select 10.

7 In the Compressed Font Name field, select a font based on the following
information.

o If you are using 8.5- x 11-inch paper on a standard-carriage printer, or 8.5- x
11-inch paper on a wide-carriage printer, select 17 CPI Draft,
17 CPI Courier (not Courier New), or any font other than Default.

o If you are using 11- x 14-inch paper, select a value between 10 and 15 (this
setting may vary, depending on which printer driver you are using).

8 Click Accept.
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Creating a Report Setting

After selecting the options and selection criteria for a report, you can save these
selections for future use by using a unique report setting. You can create and save
any number of customized report settings per report and company. Use this
procedure to save a report setting based on an existing report setting.

To create a report setting

1 In the report window, in the Report Setting field, select the setting to use as the
basis for your new setting.

= Budget and Histary Report (ABC) 7/25/2018 - | X
Report Setfing STANDARD |0% Save -
Description Budget and History Report |
Setting Options

Type Public - Print Report Settings |:| Number of Copies c
Default Report Three Hole Punch |:| v
Sort Report By | Account Number -
Options
Print Zero Balance Accounts | Yes -
Print Totals Onky [l
Infarmation to Print ActualBudget Fizcal Year | %
ACTUAL POSTINGS &, | 2020
ORIGINAL 2020
ACTUAL POSTINGS 20158
W
Selections
Select Field Operand Value L4
Account Number All -
Description All -
Main All -
Department All -
1 A v
Keep Window Open After

Print

D Preview D

2 To save the report setting based on another report setting, modify the settings in
the report window, and then at the Save button click the drop-down arrow and
select Save As. You can also save the current report setting by clicking Save.

The settings for the standard set of reports included with Sage 100 cannot be
modified. The settings made in the report window will revert back to the previous
Standard settings. If you’ve made changes to the settings, when you click Save,
the Save As Report Setting window opens allowing you to save the changes
using a different setting name.
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3 Inthe Save As Report Setting window, in the Description field, type the
description for the report setting you are saving.

[E] save As Report Setting ? =

Report Setting STANDARD

Description Budget and History Report

Setting Options
Type Public -
Default Report

Office Merge Options
Always use this tamplate |:|

Template O\J
| oc [ concel 7

4 In the Type field, select the report type option.

5 To save the report setting as your default report setting, select the Default
Report check box.

6 To set advanced settings for the report setting, perform the following steps:

é NoTE

Report and form a Click Advanced. In the Advanced Setting dialog box, select either the

printer Standard or Custom option to use a standard or custom report when printing
information is the report.

retained by

workstation and b If you selected the Custom option, enter the path to the custom report and

form code. When
a new report
setting or form
code is created,

click OK.

7 In the Save As Report Setting window, click OK to save the report setting.

the workstation Changes made to an existing report setting are saved to a new report setting
ID and printer name or to the current report setting name. The report setting that you created
information is will be available in the Report Setting field in the report window for future use.
retained.

Setting Up Sage Intelligence Reporting

Sage Intelligence Reporting shows your Sage 100 data in Excel templates, which
you can view and customize.

Sage Intelligence Reporting is installed by default when you install Sage 100 and
run Workstation Setup. If you modified the default installation setting, you can install
Sage Intelligence Reporting at any time. Refer to the Sage 100 ERP Installation and
System Administrator’s Guide for installation instructions.

Before using Sage Intelligence Reporting, you must set up a repository and register
the product.
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The repository will be used to store Sage Intelligence Reporting data, reporting
trees, report templates and other settings. Centralizing this information in one folder
has the following advantages:

e Using a single folder makes it easier to back up and restore the information.

e Multiple users can access the information.

To set up Sage Intelligence Reporting

1 Create a shared folder to serve as the repository. The folder can be created
locally or on a network; however, you must use a UNC format when entering the
repository path:

\\server\share name\repository folder name

2 Grant Sage Intelligence Reporting users read and write permissions to the
folder.

3 Open the Report Manager from within Sage 100. Select Sage Intelligence
Reporting > Reports > Report Manager.

4 When the window appears asking for the path to the repository, enter the UNC
path to the shared folder that you created, and click OK.

5 When a window appears asking you to run the license manager, click Yes.

6 Inthe License Manager window, enter your Sage customer account number and
serial number, and then click Apply.

The serial number is also referred to as an unlocking key. If you do not have
your serial number, see Finding Your Serial Number on page 69.

7 Click Perform Registration.

Click the Help button on any Sage Intelligence Reporting window for detailed
information about the product’s features.

Finding Your Serial Number

If you do not have your Sage Intelligence Reporting serial number, you can find it
online at: https://customers.sagenorthamerica.com. You’ll need your user name and
password.

To find your Sage Intelligence Reporting serial number
1 Go to https://customers.sagenorthamerica.com and log on.
2 From the Activation Codes menu, click Details.

3 In the Product Details grid, in the Application column, look for Intelligence
Report Mgr. Your serial number is in the Unlocking Key column.

The serial number is case-sensitive. All special characters must be copied or typed
into the License Manger screen exactly as it appears in the Product Details grid.
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The TF (Taxable
Freight) tax class
is used to
calculate sales
tax on freight
amounts.
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You may have additional Sage Intelligence Reporting components listed in the grid.
The serial number for the Intelligence Report Mgr component will unlock all of the
components.

Setting Up Sales Tax Information

Depending on the states in which you conduct business and the type of business
you have, you may be required to calculate sales tax on items sold and items
purchased. The software allows you to calculate, track, and report sales tax
information. To calculate sales tax, you must define information in Sales Tax Class
Maintenance, Sales Tax Code Maintenance, and Sales Tax Schedule Maintenance.
Sales tax information defined in these tasks is available to all companies.

The setup of sales tax information consists of the following four-part process:

1 Defining Sales Tax Classes: The tax class is used to define tax classifications.
These tax classes are then assigned to each sales code, inventory item and
miscellaneous charge code.

2 Defining Sales Tax Codes: The tax code is used to define whether a tax class is
taxable. It is also used to define a tax rate, if applicable.

3 Defining Sales Tax Schedules: A tax schedule groups individual tax codes.

4 Assigning Sales Tax Schedules: Tax schedules are assigned to each vendor and
customer based on the vendor's location or purchase address and the
customer's location or ship-to address.

Defining a Sales Tax Class

The first step in defining sales tax information is to define different types of tax
classifications in Sales Tax Class Maintenance. The following three tax classes are
defined automatically by the system and cannot be deleted: Nontaxable (NT),
Taxable (TX), and Taxable Freight (TF). A tax class must be defined for each
classification of goods and services that are taxed at different rates.

To define a sales tax class
1 Select Library Master Setup menu > Sales Tax Class Maintenance.

2 Enter a class in the Tax Class field.
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3 In the Description field, type a description for the tax class and click Accept.
Repeat steps 2 and 3 for each tax class you need to define.

[E] sales Tax Class Maintenance (ABC) 8/2/2018 — O bt
Tax Class Description =
)
Nontaxabl
1 NT ontaxable % .
2 TF Taxable Freight
3 | TX Taxable

EIESNs o

After defining sales tax classes, assign the tax classes to sales codes, inventory
items, and miscellaneous charges.

Defining a Sales Tax Code

After defining tax classes, you must define sales tax codes in Sales Tax Code
Maintenance. You must set up a tax code for each tax jurisdiction (such as state,
county, local or province) to which your business reports sales tax information. The
defined sales tax codes determine the rate to calculate for each tax class defined in
Sales Tax Class Maintenance and are used to determine if sales tax is calculated on
both items sold and purchased.
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To define a sales tax code
1 Select Library Master Setup menu > Sales Tax Code Maintenance.

2 Enter a code in the Tax Code field and type a description in the Description field.

E Sales Tax Code Maintenance (ABC) 8/2/2018 — O *

Tax Code Ca Q\_, 4 4 & kb

Description |Ca|ifnrniﬂ | Short Description

Taxable Limit Calculate Sales Tax on Retention |:|
Expense to Vendor/tem Tax on Tax | Tax Class CL
Tax Class Description Tax Rate Sales | Purchases | Monrecoverable Pct =_a,'¢
1 NT Nontaxable .000000 | | 000 :gd -
2 |TF Taxable Freight .000000 | | .000
3 | TX Taxable 7.250000 [« 1 000
| Q, ooooo0 [ | 000

EEIESEE G o

3 If the tax code you are defining has a limit, type it in the Taxable Limit field. For
example, some tax jurisdictions have a limit for the amount of sales tax that can
be defined on an invoice, sales order, or receipt.

4 In the Short Description field, type a short description. This description will be
used when printing tax detail on forms.

& Note 5 Complete one of the following options:
The Calculate
Sales Tax on o Select the Calculate Sales Tax on Retention check box to calculate sales tax

Retention check
box is available
only if the Job
Cost module is
installed.

on the invoice amount less retention.

o Clear the Calculate Sales Tax on Retention check box to calculate the sales
tax on the full invoice amount, regardless of retention. For more information,
see Sales Tax Code Maintenance - Fields in the Help system.

6 Complete one of the following options:

o Select the Expense to Vendor/ltem check box to allocate the
non-recoverable portion of purchase's sales tax to the vendor's expense
account in Accounts Payable or to the inventory account in Purchase Order.
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The Tax Class
field next to the
Tax on Tax check
box is the only
place you can
enter a tax-on-tax
tax class; you
cannot enter this
in Sales Tax
Class
Maintenance.

é NoTE

If your tax
jurisdiction
charges tax on
freight, you must
set up a tax rate
for the TF tax
class in each
applicable tax
code.
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o

Clear the Expense to Vendor/ltem check box if the non-recoverable portion
is not to be allocated. For more information, see Sales Tax Code
Maintenance - Fields in the Help system.

Complete one of the following options:

o

Select the Tax on Tax check box if this tax code is subject to taxation by other
tax jurisdictions, and proceed to step 8.

Clear the Tax on Tax check box if the tax code is not subject to tax on tax,
and proceed to step 9. For more information, see Sales Tax Code
Maintenance - Fields in the Help system.

If you selected the Tax on Tax check box, enter a class to be used for tax-on-tax
calculations in the Tax Class field (next to the Tax on Tax check box).

For each tax class defined (except for tax class NT which cannot be maintained
or deleted), complete the following fields:

a

Select the Sales check box to calculate sales tax for this code, or clear the
Sales check box if sales tax should not be calculated.

In the Tax Rate field, type the tax rate percentage to use for calculating
taxes.

Select the Purchases check box if purchases are taxable for the tax class
entered and proceed to step d. Clear the Purchases check box if the
purchases are not taxable and proceed to step e.

If the Purchases check box is selected, type the percentage of the purchase
tax that cannot be recovered in the Non-Recoverable % field. Type 0 (zero)
at this field if all purchases sales tax is to be posted to the Accounts Payable
sales account. Type 100 at this field to post all of the purchases sales tax to
the non-recoverable account.

Click OK.
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10 Click Accept. The following example shows a rate of 7.25, which will be
calculated for items assigned to the Taxable (TX) tax class for items sold.

Tax Code CA

E Sales Tax Code Maintenance (ABC) 8/2/2018

S E NN

Description | California

Short Description

Taxable Limit Calculate Sales Tax on Retention |:|
Expense to Vendor/tem Tax on Tax [l Tax Class Q\J
Tax Class Description Tax Rate Sales | Purchases | Nonrecoverable Pct
1 NT Nontaxable .0ooo00 | O 000
2 |TF Taxable Freight .0ooo00 O O 000
3 | TX Taxable 7.250000 ™4 ] 000
| Q, oooooo [ O 000

EIETE G o

a0l

Defining a Sales Tax Schedule

After defining sales tax codes, use Sales Tax Schedule Maintenance to group tax
codes that make up a total sales tax rate for assignment to customers and vendors,
and to establish whether tax detail will print on sales orders and invoices. For
example, if a specific county requires that you calculate both state and county tax,

create a sales tax schedule that groups the state and county tax together.

To define a sales tax schedule

1

2

Getting Started Guide

Select Library Master Setup menu > Sales Tax Schedule Maintenance.

Enter a schedule in the Tax Schedule field and type a description in the

Description field.

In the Tax Code field, enter a tax code to add to this tax schedule and click OK.
Repeat this step for each tax code you want to add to the tax schedule.

The sequence in which the tax codes are entered is very important because of
tax-on-tax calculations and the establishment of the primary tax code. If a tax

code is taxable by another tax code, it must be calculated first. For example, if
tax code CA is taxable by tax code OR, CA would have to be calculated first to
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get an accurate calculation for the OR tax code. The first tax code entered will
become the primary tax code. The primary tax code is used during the
calculation of taxable and nontaxable amounts on each invoice and
printing/updating of sales tax history.

=] sales Tax Schedule Maintenance (ABC) 8/2/2018 — O >
Tax Schedule | CABA L4 bW ZIP XRef...  State XRef...
Description Bart |
Print Tax Code Detail |
Tax Code Description =>'\{
CA California (Primary) % -
2 CABA Bart

EN 2

li

EIESIEDN G 6

4 Click Accept.

Assigning a Sales Tax Schedule

After sales tax schedules are defined, use Customer Ship-To Address Maintenance
and Purchase Address Maintenance to assign each customer and vendor address
to a default tax schedule. Default tax schedules can be changed when entering
transactions.

To assign a sales tax schedule to a customer address
1 Select Accounts Receivable Main menu > Customer Maintenance.

2 Enter the customer number. Click the drop-down arrow in the top-right corner of
the window, and then click Ship To Address.

3 In the Customer Ship-To Address Maintenance window, enter the Location
Code field.
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4

In the Tax Schedule field, enter a sales tax schedule and click Accept.

E Customer Ship-To Address Maintenance

Location Code

Name:

Address

ZIP Code

City

Country
Telephone

Fax

E-mail Address
Contact
Warehouse
Salesperson
Ship Vig

Sales Tax
Tax Schedule

1 CL 144 b bl

Avnet Processing Corp |

Western Division @
1311 NW. 15th Street

Residential Address [ |

92653 |
Mirimar |5tate |CA |
usa |G, United States
(213) 555-9842 Ext |:|
Batch Fax [_]
[ca & caifornia
Accept

EERIETE S ©

Exemptions...
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To assign a sales tax schedule to a vendor address

1

2

Select Accounts Payable Main menu > Vendor Maintenance.

Enter the vendor number. Click the drop-down arrow in the top-right corner of
the window, and then click Purchase Address.

In the Purchase Address Maintenance window, enter the location code.

In the Tax Schedule field, enter a sales tax schedule and click Accept.

E Purchase Address Maintenance ? *
Location Code LA C% M 4 b @
Name | ARWAY PROPERTY
Address 1001 PICO BLVD. &
ZIP Code 92145 |
City LOS ANGELES |5tate |CA |
Country USA |Cl§ United States
Telephone (213) 55938383 Ext |:|
Fax (213) 593-8000 Batch Fax [ ]

E-mail Address
Contact

Sales Tax
Tax Schedule

Exemption Mo. on File

JOHNHLL &, John Hil

LA
O

EEEIEE s o
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Understanding How Sales Tax is Calculated

This lesson provides examples of how sales tax is calculated. These examples use
the WI (Wisconsin) and WI MIL (Milwaukee) sales tax codes:

e The WI (Wisconsin state tax) sales tax code is set up to calculate sales tax at a
rate of 5% on all sales and purchases for items assigned to the Taxable tax
class. It will not calculate sales tax on other tax classes.

e The WI MIL (Milwaukee city tax) sales tax code is set up to calculate sales tax at
a rate of 1% percent on all sales for items assigned to the Taxable tax class. It
will not calculate sales tax on purchases or items assigned to other tax classes.

£ sales Tax Code Maintenance (ABC) 8/2/2018 — O bt
Tax Code wi Q\J ld 4 b &
Description |'L-'Ji3 consin | Short Description
Taxable Limit Calculate Sales Tax on Retention |:|
Expense to Vendor/tem Tax on Tax | Tax Class CL
Tax Class Description Tax Rate Sales | Purchases | Monrecoverable Pct =_a,'¢
1 —_— —_—
£ sales Tax Code Maintenance (ABC) 8/2/2018 — O bt
Tax Code | WIMIL CLid 4 b
Description |Milwaukee | Short Description
Taxable Limit Calculate Sales Tax on Retention |:|
Expense to Vendor/tem Tax on Tax | Tax Class CL
Tax Class Description Tax Rate Sales | Purchases | Monrecoverable Pct =_a,'¢
— 1 NT Nontaxable .000000 | | .000 :gd -
2 |TF Taxable Freight .000000 | | .000
3 | TX Taxable 1.000000 [« 1 000
4 |a 000000 [ 1 000

EEIESEE G o

These examples also use the WI (Wisconsin) and WI MIL (Milwaukee) sales tax
schedules:

e The WI (Wisconsin) sales tax schedule has the WI sales tax code assigned to it.

Getting Started Guide Page 78



Understanding How Sales Tax is Calculated

e The WI MIL (Milwaukee) sales tax schedule has both the WI sales tax code and
the WI MIL sales tax code assigned to it because Milwaukee city requires that
both state and city tax be calculated for taxable items.

E Sales Tax Schedule Maintenance (ABC) 8/2/2018 — O *
Tax Schedule Wl CLid 4 b ZIPXRef . State XRef
Description |Wi3cx|n3in |
Print Tax Code Detail I
E Sales Tax Schedule Maintenance (ABC) 8/2/2018 — O *
Ti
1wl Tax Schedule | W1 MIL CLid 4 b bl ZIP¥Ref ..  State XRef .
ﬁ Description Milwaukee | Next | |
Print Tax Code Detail ]
Tax Code Description | =3'g
1 Wi Wisconsin (Primary) % -
2 Wil MIL Milwaukee &
q‘
=N a ] -

RN S O
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Example 1 - How Sales Tax is Calculated in Accounts
Receivable

This example shows how sales tax is calculated on Accounts Receivable invoice
1000158-IN. Invoice 1000158-IN has the following settings:

e On the Invoice Data Entry Header tab, the WI tax schedule is selected.

e On the Invoice Data Entry Lines tab, line item 1 (Standard Gadget) is $145 and is
assigned to the TX tax class, indicating that this item is taxable.

5] AR Invoice Data Entry (ABC) 8/1/2018 - O %
Invoice Number 010005&-N L [ 14 4 b B 2 Cusfomer..  Credit...
4. Header 2. Lines 3. Totals 4. Payment
[E 2/R Invoice Data Entry (ABC) 8/1/2018 - O x
Customer No. )
Invoice Number  0100058-N O [ 14 4 B B [ Cusfomer..  Credit...
1. Header 2. Lines 2. Totals 4. Payment
Customer PO
wiskrow | 1@ B EReELy-
tem Code Quantity | Price | Amount | Comment
Invoice Date 1| 100-AA 1.000 145.000 145.00
Due Date 2 000 000 .00
Discount Date
Net Invoice Amt
Sales Tax
Schedule Wi
Wisconsin
< >
Description | Standard Gadget ~
GL Account | 400-01-00
Cost 56.000
@ ofickF TaxClass | TX .
WI (Wisconsin) Net Invoice
sales tax
Quick Print.. Accept Cancel .
selected. @ % 0..-:

TX tax class is
selected for the
Standard Gadget.

Getting Started Guide Page 80



Understanding How Sales Tax is Calculated

Tax Calculated Using the WI (Wisconsin) Sales Tax Schedule

To view how tax is calculated for invoice 1000158-IN, on the Invoice Data Entry
Totals tab, click Tax Detail. In the Tax Detail window, you can see that $7.25 (100 x
7.25%) in sales tax has been calculated for the WI (Wisconsin) sales tax schedule.

] Tax Detail O
WI (Wisconsin)
sales tax Document  [0100058-IN Customer |31-R55L|PPL | R & S Supply Corp.
schedule is — Schedule Wl Wisconsin
selected.

Tax Code Tax Amount | Exemption Number | Taxable Sales | Nontaxable Sales| Exe
1 Wil 725 145.00 .00
< >
Total 7.25

0

Getting Started Guide

$7.25 sales tax is
calculated.
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Tax Calculated Using the WI MIL (Milwaukee) Sales Tax Schedule

For invoice 1000158-IN, if the tax schedule on the Invoice Data Entry Header tab is
changed from WI tax schedule to WI MIL tax schedule, sales tax is calculated for
both the Wisconsin state (WI) and Milwaukee city (WI MIL) sales tax codes because
both of theses sales tax codes are included in the WI MIL tax schedule.

The following Tax Detail window shows how tax is calculated when the

WI MIL tax schedule is used. You can see that $7.25 (100 x 7.25%) in sales tax is
calculated for the (WI) Wisconsin sales tax code, and $1.45 is calculated for the (WI
MIL) Milwaukee city sales tax code. The total tax amount is now $8.70 for the
invoice.

WI MIL
(Milwaukee) Document  (0100058-IN Customer |01-RSSUPPL R & S Supply Corp.
sales tax ——— schedule Milwaukee
schedule is
selected. —
Tax Code Tax Amount Exemption Mumber | Taxable Sales |Nontaxable Sales| Exq ==
Wi 725 145.00 .00
2 WIMILL 1.45 145.00 00

] Tax Detail O >

Total 8.70

Getting Started Guide

$8.70 sales tax is
calculated.
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For invoice 1000158-IN, let's say the same tax schedule of WI MIL is used; however,
the tax class for the Standard Gadget item on the Invoice Data Entry Lines tab has
been changed from TX (Taxable) to NT (Non Taxable).

The following Tax Detail window shows how tax is calculated when the
NT tax class is assigned to the Standard Gadget item. Notice that sales tax is not
calculated and the entire invoice displays as a nontaxable sale.

[ A/R Invoice Data Entry (ABC) 8/1/2018 - O *

Invoice Number | 0100058-N L [ 14 4 B B 2 Cusomer..  Credi..

1. Header 2. Lines 3. Totals 4. Payment
Quick Row E = =S e S -

ltem Code Quantity | Price | Amount | Comment
1 100-A4 |EL 1.000 145.000 145.00
2 .00a .00a .00

E Tax Detail O x

Document  |0100052-IN Customer |31-R55L|F‘PL |R&55up|}h{ Corp.
g Schedule  [WIMIL Wilwaukee

Description Stang .
GL Account | 400 Tax Code Tax Amount | Exemption Number | Taxable Sales | Nontaxable Sales| Exg -
Cost 1 Wi .00 .00 145.00
TaxClass | NT 2 [ 00 .00 145.00
@ auickppnt. | £ >

Total

NT tax class is
selected for the
Standard Gadget.

No sales tax is calculated.
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Example 2 - How Sales Tax is Calculated in Accounts
Payable

This example shows how sales tax is calculated on Accounts Payable invoice
75-145. Invoice 75-145 has the following settings:
e On the Invoice Data Entry Header tab, the WI MIL tax schedule is selected.

On the Invoice Data Entry Lines tab, the total distribution amount for this invoice
is $100.00. This is the total purchase amount that is taxable.

= 4/P Invoice Data Entry (ABC) 8/2/2018 - O >
Vendor No. | 01-STEVW Ck‘ SeoMod BB g Wendor...
MName Stevens Supply
Invoice Mp.  [75-145 |Clh =]
1. Header 2. Lines
invoice Date 5312020 | Terms Code 02 [@, 2% 10 DAYS, NET 30 DAYS

Invoice Amount 105.00 [z Invoice Due Date 6/30/2020 =]
Freight 00 [ Discount Due Date | 6/10/2020 e
Sales Tax =
| 5 AP Invoice Data Entry (ABC) 8/2/2018 - O X
Subject to Discount
Prepaid Invoice Wendor Mo. | 01-STEV C% o o4 bRl g Vendor..
Hame Stevens Supply
Inwoice No. T5-145
Sales Tax C% m
Schedule [WINIL @[ 1 Header | Z Lines
Tax Class ck
. = =
UseTax [ | Quick Row @ ER LS
G/L Account Amount | Comment |
@ 1oggs00202 18 100.00
2 .00
WI MIL (Milwaukee)
sales tax schedule is
selected.
Description | Freight - West
Distribution Balance 5.00 Total 100.00

Getting Started Guide
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$100.00 is entered
for the distribution
amount.
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Tax Calculated Using the WI MIL (Milwaukee) Sales Tax Schedule

To view how tax is calculated for invoice 75-145, on the Invoice Data Entry Header
tab, click Tax Detail. In the Tax Detail window, you can see that $5.00 (100 x 5%) in
sales tax has been calculated for the WI MIL (Wisconsin) sales tax schedule.

Remember that the WI MIL tax schedule calculates tax for both WI (Wisconsin state)
and WI MIL (Milwaukee city) sales tax codes. Also, keep in mind that the W1 sales
tax code is set up to calculate sales tax on items which are purchased (the
Purchases check box is selected in Sales Tax Code Maintenance), but the WI MIL
tax code is not set up to calculate sales tax on items which are purchased (the
Purchases check box is cleared in Sales Tax Code Maintenance). Therefore, sales
tax on purchased items is calculated only for the WI (Wisconsin) state tax code even
though both tax codes (WI and WI MIL) are included in the WI MIL tax schedule.

WI MIL (Milwaukee) sales tax schedule is selected.

E] Tax Detail a *
Document T75-145
Vendor Stevens Supply
—— Schedule Miwaukee
Tax Code Tax Amount Use Tax Amt Exempt on File Exemption Number | Taxab %
N 5.00 00 O
2 | WIMIL .00 .00 |
£ >
Total 5.00

Getting Started Guide

$5.00 sales tax is calculated.
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Changing Sales Tax Information
After setting up sales tax information, you may need to modify the sales tax

é NoTE

This 'eSSOt: t information defined in Sales Tax Class Maintenance, Sales Tax Code Maintenance,
::ISGUS”::)? a or Sales Tax Schedule Maintenance. For example, the sales tax rate for a tax

information has jurisdiction changed.

been set up and
sales tax has
already been
calculated on 1
transactions.

To change sales tax information

Select Library Master Setup menu > Sales Tax Class Maintenance, Sales Tax
Code Maintenance, or Sales Tax Schedule Maintenance.

2 The following warning appears informing you that changes you make may
impact sales tax calculations and reporting. Click OK.

] sage 100 *

3 ‘Warning: Any changes may impact sales tax calculations and reporting. Make sure that no data entry is in progress. After changes have been made, run the
\\J) Sales Tax Calculation Utility from Accounts Receivable or Accounts Payable Utilities for each applicable company.

3 Make the necessary changes in Sales Tax Class Maintenance, Sales Tax Code
Maintenance, or Sales Tax Schedule Maintenance and click Accept.

AWARNING 4 You must recalculate the sales tax previously calculated on unposted invoices,
Before sales orders, purchase orders, manual checks, returns, and so on. To do this,
recalculating select either Accounts Payable Utilities menu > Sales Tax Calculation or
sales tax, back up Accounts Receivable Utilities menu > Sales Tax Calculation.
all data files.

5 In the Sales Tax Calculation Utility window, select one of the following options:

é NoTE

Records that
have a status of
"invalid tax
calculation”
display the
Recalc Tax
button in data
entry.
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o Select the Recalculate Sales Tax for all Records option to recalculate taxes
for all records.

o Select the Recalculate Sales Tax for Flagged Records Only option to
recalculate taxes for only those records that are flagged as invalid tax
calculation.

E AJP Sales Tax Calculation (ABC) 5/31... — *

Sales tax wil be recalculated for the items selected below based on
the current tax information.

i PIO Orders
AJP Invoices Pi0 Receipts
AP Manual Checks FIO Returns
Recalculate Sales Tax for all Records @
Recalculate Sales Tax for Flagged Records Only O

N o
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6 Click Proceed to recalculate the sales tax.
When sales tax is recalculated, the following occurs:

e Only unposted transactions are affected. This includes sales orders, purchase
orders, and unposted invoices.

e Posted transactions are not modified. If the amount of sales tax calculated was
incorrect, you must manually adjust the invoice through a credit memo or debit
memo.

e Recurring invoices are updated if they contain sales tax information.
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Troubleshooting

What are System Messages?

When the computer system encounters a condition requiring your attention, a
System Message dialog box appears.

System Message Dialog Box Example

[ Error Encountered X

Error 90. Unabls to locate Object class definition
Program..... PR_EMPLOVEE_ULPVC
Statement..... 867

CIass........... PR_Employes_ui
Hethod........ PostReadRec

Some messages reflect a normal operational situation, such as the printer being
off-line. Usually, the resolution is simple, and you can proceed without difficulty.

Other messages can indicate a problem with the hardware or with the data files. A
problem of this nature may require help from your Sage business partner.

Obtaining Additional Information

If a message dialog box appears, click Info in the Error window to obtain additional
information about the message.
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[ Error Encountered X
Error 90. Unable to locate Object class definition
Program. PR_EMPLOYEE_ULPVC

Statement..... 897

Class...... PR_Employee_ui

Method......... PostReadRec

Click System Info to view
information regarding the
workstation. This utility does not
contain information specific to

E Error
Q 80 Error #30: Unable to locate Object class defintion
Program PR_EMPLOYEE_UlLpvc Line 897

Info Objects Files Stack

Error Information

Last Channel Opened 32694
Last ChannelAccessed 32896
Last File Name: C:\Sage\Standard 2019WASSIWAS_ABCWPRABC\PR_TimeTrack M4T
Last Key Value
Last Key Text
Object Number 100011
Object Method PostReadRec

Object Text PR_Employee_ui

the software.

Available Memory 25858721
System Info
eoug ey [HETH S @
E Error X
90  Error #30: Unable to locate Object class definition
Program PR_EMPLOYEE_Ulpvc Line es7
Infe Objects Stack
Open Files
Channel File Name -
32692 *memory*®
32693 *memory*®
32694 *memory*
32685 C:\Sage\Standard 201 9MASSINLOCK,_ABC\PR_TimeTrack LCK
32698 C:\Sage\Standard 2019MASS0VMAS_ABC\PRABC\PR_TimeTrack M4T
32697 *memory™
32698 C:ASage\Standard 2015WWMASS0LOCK\_ABC\PR_Employee LCK
32699 C:\Sage\Standard 2019MASIIMAS_ABC\PRABC\PR_Employee. M4T
32700 *memory*
32701 C:\Sage‘Standard 2019WMASS0MAS_ABC\PRABC\PR_Department. M4T
32702 *memory*
32703 *memory™
32704 *memory™
v
eoug ey [HETH S @

Before contacting a Customer Support or your Sage business partner, write down
any system messages appearing on your monitor. Copy the message and indicate
the program and function being performed when the message occurred. Click the
Print button to print the error information.

Getting Started Guide

Page 89



Appendix B

& NoOTE

The eBusiness
Manager,
Material
Requirements
Planning, and
Work Order
modules are not
available for
Sage 100
Premium.

Overview of Module Startup

This appendix explains how to successfully upgrade from another business
management system to Sage 100 for the following modules:

e Accounts Payable

e Accounts Receivable

e Bank Reconciliation

e Bar Code

e Bill of Materials

e Common Information Setup Wizard
e eBusiness Manager

e General Ledger Setup Wizard

e Inventory Management Setup Wizard
e Job Cost

e Material Requirements Planning

e Payroll

e Purchase Order

e Sales Order

e Work Order

This appendix is organized alphabetically for ease of reference.

Getting Started Guide

Page 90



Accounts Payable

Accounts Payable

Accounts Payable Setup Wizard

& NoTe The Accounts Payable module includes an Accounts Payable Setup Wizard that you

Set up your sales must perform to convert your existing companies and account structure.
tax codes, sales

tax classes, and The Accounts Payable Setup Wizard provides several pages of questions and

zi:ﬁ:df}zs in options that aid you in quickly setting up the Accounts Payable module for new
Library Master companies; you must complete this wizard and the Conversion Process on page 91
before using the before using the Accounts Payable module.

Accounts

Payable Setup Data You Need

Wizard.

Before using the Accounts Payable Setup Wizard, have the following information
assembled and available for use:

e Your General Ledger Chart of Accounts

e Your bank account number(s) for the checking accounts used by Accounts
Payable

e Alist of standard payment terms offered by your vendors
e Alist of your vendors, including address and phone numbers
e Alist of all unpaid invoices to be processed

To obtain correct information from your Accounts Payable module, you must first
bring it up to date with your existing accounts payable system.

Conversion Process

Complete the following process to ensure that your system is current. These steps
should be performed after completing the setup wizard and after adding all of your
information to the Accounts Payable module.

To convert your existing accounts payable system
1 Identify all unpaid invoices as of your last closed accounting period.

2 Prepare an adding machine tape totaling the invoices. This amount should
equal the account balance for Accounts Payable in your general ledger.

3 Set the posting date to the last day of the last closed accounting period.

4 Using Invoice Data Entry, enter these invoices into the system. Enter the
outstanding balance amount for each invoice as of the end of the last closed
accounting period. During the distribution process, post the entire distribution
balance to your Accounts Payable general ledger account. This is done
because you have already expensed these invoices in a previous accounting
period, and to do so again would duplicate those expenses.
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By posting to the Accounts Payable account, both a debit and an automatic
credit are generated in the same amount to the Accounts Payable general
ledger account; therefore, the two amounts offset each other and there is no
effect on the general ledger. After the conversion process, you would not
normally post to the Accounts Payable general ledger account, but would post
to individual general ledger accounts, as appropriate.

As an alternative to this procedure, clear the General Ledger check box in
Accounts Payable Options. You can then distribute invoices to their respective
accounts and no general ledger postings are made. If you use this alternate
procedure, be sure to select the General Ledger check box again in Accounts
Payable Options after the conversion process has completed and you have
updated the Daily Transaction Register.

Print the Invoice Register. The total shown on the Invoice Register should equal
the total on the adding machine tape prepared in step 2. If it does not, an error
has been made. Check your adding machine tape and Invoice Register, return
to Invoice Data Entry and make any necessary corrections, and then reprint the
Invoice Register.

Update the invoices.

Print the Aged Invoice Report available on the Accounts Payable Reports
menu, and retain a copy of this report for your accounting files. Again, the total
on this report should equal the adding machine tape total.

Run Period End Processing by selecting Period End Processing from the
Period End menu, and then clicking Proceed.

Reset the posting date to the first day of the current accounting period.

Using Invoice Data Entry, enter any invoices you have received since the last
closed accounting period. (These invoices should not include any invoices
entered in step 4.) Post the distribution balance of each invoice to its
appropriate general ledger account (not to the Accounts Payable general ledger
account). Print the Invoice Register and update the invoices.

Prepare an adding machine tape totaling any checks you have written since
your last closed accounting period.

Using Manual Check and Payment Entry, enter these checks (step 11) into the
system. If the check paid an invoice previously entered (step 4 or 10), no
general ledger distribution is required. Type the invoice number exactly as you
did when you entered it in step 10. If the check paid an invoice that you did not
previously enter, you must distribute it to the appropriate general ledger
account(s).

Print the Manual Check and Payment Register. The total should equal the total
of the adding machine tape prepared in step 11. If it does not, return to Manual
Check and Payment Entry, correct the necessary entries, and reprint the
Manual Check and Payment Register. When the register total and the adding
machine tape agree, update the manual checks.
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14 Print the Aged Invoice Report and verify that all invoices paid by the manual
checks recorded in step 12 are listed as paid.

You are ready to begin using your Accounts Payable module.

Accounts Receivable

Accounts Receivable Setup Wizard

The Accounts Receivable module includes an Accounts Receivable Setup Wizard
that you must perform to convert your existing companies and account structure.

The Accounts Receivable Setup Wizard provides several pages of questions and
options that aid you in quickly setting up the Accounts Receivable module for new
companies; you must complete this wizard and the Conversion Process on page 93
before using the Accounts Receivable module.

Data You Need

Before using the Accounts Receivable Setup Wizard, have the following information
assembled and available for use:

e Your General Ledger Chart of Accounts

e Alist of jurisdictions in which you sell and collect sales tax and their tax rates
e Alist of standard payment terms offered to your customers

e Alist of your customers, including addresses and phone numbers

e Alist of all invoices to process

e Alist of all payments to process

To obtain correct information from your Accounts Receivable module, you must first
bring it up to date with your existing accounts receivable system.

Conversion Process

Complete the following process to ensure that your current accounting system is in
balance. These steps should be performed after completing the setup wizard and
after adding all your customers to the Customer file. If you maintain Accounts
Receivable customers using a balance forward method, it is not necessary to enter
each invoice. For balance forward customers, total all unpaid invoices for each aging
category, and enter an invoice for each aging category for each customer.

To convert your existing accounts receivable system
1 Identify all unpaid invoices as of your last closed accounting period.

2 Prepare an adding machine tape totaling the invoices. This amount should
equal the account balance for Accounts Receivable in your general ledger.
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Set the posting date to the last closed accounting period.

Using Invoice Data Entry, enter the invoices using the original invoice dates.
During the distribution process, post the entire distribution balance to your
Accounts Receivable general ledger account number. These invoices are
already posted in an accounting period, and to post them again would duplicate
the postings.

By posting to the Accounts Receivable general ledger account, both a credit
and an automatic debit are generated in the same amount to the Accounts
Receivable general ledger account. The two amounts offset each other and
there is no effect on the general ledger.

After the conversion process, you will not normally post to the Accounts
Receivable general ledger account, but will post to individual general ledger
accounts, as appropriate.

As an alternative to this procedure, in Accounts Receivable Options, clear the
General Ledger check box. You can then distribute invoices to their respective
accounts and no general ledger postings will occur. If you use this alternate
procedure, be sure to select the General Ledger check box again in Accounts
Receivable Options after the conversion process has completed and you have
updated the Daily Transaction Register.

Print the Sales Journal. The invoice total shown on the Sales Journal should
equal the total on the adding machine tape prepared in step 2. If it does not, an
error has been made. Check the adding machine tape and the Sales Journal,
return to Invoice Data Entry and make any necessary corrections, and then
reprint the Sales Journal.

Update the invoices.

Print the Aged Invoice Report and retain a copy of this report for your
accounting files. The total on this report should equal the adding machine tape
total.

Run Period End Processing by selecting Period End Processing from the
Period End menu, and then clicking Proceed.

Reset the posting date to the first day of the current accounting period.

Using Invoice Data Entry, enter any invoices billed since the last closed
accounting period. (These invoices should not include any invoices entered in
step 4.) Post the distribution balance of each invoice to its appropriate general
ledger account (not to the Accounts Receivable general ledger account). Print
the Sales Journal and update the invoices.

Prepare an adding machine tape totaling any cash receipts you received since
your last closed accounting period.
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Using Cash Receipts Entry, enter these cash amounts. For the deposit amount,
enter the adding machine tape total prepared in step 11. If the checks entered
represent payment for a previously issued invoice (step 4 or 10), no general
ledger distribution is required. If any checks represent payment for an invoice
not previously issued, you must distribute the amounts to the appropriate
general ledger accounts.

Print the Cash Receipts Journal. The total should equal the adding machine
tape total in step 11. If it does not, return to Cash Receipts Entry, correct the
necessary entries, and reprint the Cash Receipts Journal. When the journal
total and the adding machine tape agree, update the cash receipts.

Print the Aged Invoice Report and verify that all invoices that are paid by the
cash receipts recorded in step 12 are listed as paid.

You are ready to begin using your Accounts Receivable module.

Bank Reconciliation

Conversion Process

To obtain correct information from your Bank Reconciliation module, you must first
bring it up to date with your existing bank reconciliation system.

To convert your existing bank reconciliation system

1

Verify that all modules being integrated with Bank Reconciliation are fully
installed and operational.

Select the Bank Reconciliation check box in General Ledger Options, Accounts
Payable Options, Accounts Receivable Options, Payroll Options, and Purchase
Order Options, as appropriate.

Manually reconcile the last bank statement for each account that you want to
use in your bank reconciliation system.

Perform all preliminary startup activities (define the files and set the accounting
date using the ending date shown on your last reconciled bank statement).

Using Bank Code Maintenance, set up the bank code using the ending bank
balance from your last reconciled bank statement as a source for the bank
account number and ending bank balance.

Enter all outstanding checks from your last reconciled bank statement, using
Check, Deposit and Adjustment Entry. If checks are already being processed
through the Accounts Payable or Payroll module, these outstanding checks
should be checks that were updated in the check update process, but are not
shown on the last bank statement. On the Check tab, clear the Cleared check
box when these checks are recorded.
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7 Enter all outstanding deposits or adjustments (those not shown on the bank
statement) in Check, Deposit and Adjustment Entry. If deposits are being
processed through the Accounts Receivable module, these outstanding
deposits should have been updated, but not shown, on the last bank statement.
On the Check tab, clear the Cleared check box when these deposits and
adjustments are recorded.

Print the Bank Reconciliation Register to verify the accuracy of the information
entered. If the information on the register is correct, your Bank Reconciliation
module is now ready to use.

Bar Code

Before using the Bar Code module, create and have available the folder names that
will be used for importing files from the handheld computer. Enter this information in
Bar Code Setup menu > Bar Code Options.

Bill of Materials

Bill of Materials Setup Wizard

The Bill of Materials module includes a Bill of Materials Setup Wizard that you must
perform to convert your existing companies and account structure.

The Bill of Materials Setup Wizard provides several pages of questions and options
that aid you in quickly setting up the Bill of Materials module for new companies; you
must complete this wizard and the Conversion Process on page 96 before using the
Bill of Materials module.

Data You Need

Before using the Bill of Materials Setup Wizard, have the following information
assembled and available for use:

e Your General Ledger Chart of Accounts
e A single-level bill of materials listing for all bills you want to maintain

e Any miscellaneous codes that you want to set up, such as for overhead, labor,
and outside processing

To obtain correct information from your Bill of Materials module, you must first bring
it up to date with your existing bill-processing system.

Conversion Process

Complete the following process to ensure that your system is current. These steps
should be performed after completing the setup wizard.
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To convert your existing bill of materials system

1 Prepare a list of existing bills from your system. Verify that the information is
current.

2 Review the structure of the existing bills. When possible, employ the modular
bill structure to save work and provide increased flexibility.

3 Enter the bills in Bill of Materials Maintenance.

4 Enter the component items, miscellaneous codes, and comments for each bill.
If your bills use bill options, examine the bills to verify that all options and any
option interactions are taken into account.

5 Printa Single-Level Bill of Materials Report for all bills and verify the information
against the listings provided in your old system. Print an Indented Bill of
Materials Report and verify that the bill structure is correct and complete.

6 Print a Bill Validation Report. This report examines the entire Bill of Materials
file. Correct any inaccuracies and print this report again, if applicable.

You are ready to begin using your Bill of Materials module.

Common Information

Common Information Setup Wizard

The Common Information module includes a Common Information Setup Wizard
that you must perform to convert your existing companies and account structure.

The Common Information Setup Wizard provides several pages of questions and
options that aid you in quickly setting up the Common Information module for new
companies; you must complete this wizard before using the Common Information
module.

Data You Need

Before using the Common Information Setup Wizard, have the following information
assembled and available for use:

e Alist of miscellaneous items and charges
e Alist of sales tax jurisdictions

e Your bank account number(s)
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eBusiness Manager

eBusiness Manager Setup Wizard

The eBusiness Manager module includes an eBusiness Manager Setup Wizard that
you must perform to convert your existing companies and account structure.

The eBusiness Manager Setup Wizard provides several pages of questions and
options that aid you in quickly setting up the eBusiness Manager module for new
companies; you must complete this wizard before using the eBusiness Manager
module.

Data You Need

Before using the eBusiness Manager Setup Wizard, have the following information
assembled and available for use:

e The IP address and port number for each of the three servers (IS, SMTP, and
Web Engine)

e Alist of your item categories

e Alist of user IDs and passwords to assign to Internet-enabled customers (for the
.order applet only)

e Alist of user ID e-mail addresses and the company to which each user is
assigned

General Ledger

General Ledger Setup Wizard

The General Ledger module includes a General Ledger Setup Wizard that you must
perform to convert your existing companies and account structure.

The General Ledger Setup Wizard provides several pages of questions and options
that aid you in quickly setting up the General Ledger module for new companies; you
must complete this wizard and the Conversion Process on page 99 before using the
General Ledger module to process your daily transactions.

Data You Need

Before using the General Ledger Setup Wizard, you should have the following
information assembled and available for use:

e Your General Ledger Chart of Accounts
e A Trial Balance from the last completed accounting period

e Copies of your company's latest financial statements, including the Income
Statement and Balance Sheet
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Conversion Process

To obtain correct information from your General Ledger module, you must first bring
it up to date with your existing general ledger system.

e If you are converting at the beginning of a fiscal year, or require only the
beginning balances for each account, see Enter Beginning Balances in the Help
system.

e If you are converting in the middle of a fiscal year and want to record activity for
each accounting period of the current year, as well as beginning balances, see
Enter Data for Each Period in the Help system.

Use these procedures as a checklist to ensure that your current accounting system
is in balance. These procedures should be performed after completing the General
Ledger Setup Wizard.

Inventory Management

Inventory Management Setup Wizard

The Inventory Management module includes an Inventory Management Setup
Wizard that you must perform to convert your existing companies and account
structure.

The Inventory Management Setup Wizard provides several pages of questions and
options that aid you in quickly setting up the Inventory Management module for new
companies; you must complete this wizard and the Conversion Process on page 99
before using the Inventory Management module.

Data You Need

Before using the Inventory Management Setup Wizard, have the following
information assembled and available for use:

e Your General Ledger Chart of Accounts

e Alist of all inventory items containing costs, prices, on-hand quantities,
warehouse locations, and reorder requirements

e Any shipping documents, receiving reports, open purchase orders, or adjustment
vouchers that must still be processed

To obtain correct information from your Inventory Management module, you must
first bring it up to date with your existing inventory system.

Conversion Process

Complete the following process to ensure that your current accounting system is in
balance. These steps should be performed after completing the setup wizard and
after adding all your inventory items to the Inventory file.
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To convert your existing inventory system

1
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Prepare a list of current on-hand quantities for all inventory items. You can use
the balances as of your last closed inventory accounting period end, or you can
perform a physical count.

In Inventory Management Options, in the Current Inventory Period field, select
the previous period (the last closed period).

In Inventory Management Options, clear the General Ledger check box.
Set the posting date to the last day of the last closed accounting period.

In Transaction Entry, enter each item's current on-hand quantity as a receipt by
selecting Receipts in the Transaction Type field. You must enter the quantity on
hand and the unit cost for each item.

You can use a single receipt reference for entering the on-hand quantities for all
items, or items can be separated into any logical grouping and entered under
different references.

Print the Transaction Journal and verify all information. If necessary, use
Transaction Entry to make corrections.

When the register is correct, perform the Transaction Journal update.

In Period End Processing, select Full Period End Processing. The current
period is set to the period in which you begin processing.

In Inventory Management Options, select the General Ledger check box.
Reset the posting date to the first day of the current accounting period.

Enter any transactions, such as sales, issues, and receipts for the current
accounting period to bring the inventory management system up to date. Use
Transaction Entry to record the transactions.

You are ready to begin using your Inventory Management module.

Job Cost

Data You Need

Before using the Job Cost module, have the following information assembled and
available for use:

Your General Ledger Chart of Accounts
Determine your accounting and billing methods
Estimates or estimate worksheets

Job contracts with all pertinent information
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e Estimated price lists

e Standard cost code list

e Job types list

e Burden rate information

e Overhead rate information

e Invoices or billing documents that need to be processed

To obtain correct information from your Job Cost module, you must first bring it up to
date with your existing job costing system.

Conversion Process

Complete the following process to ensure your system is current. These steps
should be performed after completing System Startup and adding all jobs, cost
codes, and cost types to the Job Cost master file.

To ensure that all accounting modules integrated with Job Cost, including the
Accounts Payable, Accounts Receivable, Payroll, Purchase Order, and Sales Order
modules, do not double post transactions that have been entered as part of the
conversion process, it is recommended that the conversion process be performed
immediately after the completion of period-end processing for all integrated
modules.

To convert from your existing job cost system

1 Prepare a list of job-to-date cost information, detailed by cost code and cost
type, for each open job. You should use the information from your last closed
accounting period. If you are changing the coding format of your cost codes
from your previous system, indicate the new cost codes to use for each entry.

2 InJob Cost Options, clear the Post to G/L for Direct Cost Transactions and Post
to G/L for Billing & Cash Receipt Transactions check boxes. The job-to-date
conversion information to be entered should not be posted to the general
ledger.

3 Setthe Job Cost accounting date to the last day of the last closed accounting
period.

4 In Job Posting Entry, enter a separate batch of direct cost entries for each job.
Enter a separate entry with the job-to-date units (quantity) and job-to-date cost
for each cost code and/or cost type detail. If each job contains a large number
of cost code and/or cost type detail, update each batch separately.

5 If the Accounts Receivable module is not integrated with Job Cost, use Job
Posting Entry to enter billing and cash receipt transactions for each job up to
the last closed accounting period. Do not enter any billing or cash receipts that
should be recorded in the current accounting period.
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6 If the Accounts Receivable module is integrated with Job Cost, use Job Billing
Entry to enter all invoices that have been billed to outstanding jobs. Use
Accounts Receivable Cash Receipts Entry to enter cash receipts for job
invoices. If Job Cost is integrated with the General Ledger module, you must
use General Journal Entry to back out these general ledger postings generated
for these transactions to prevent double posting of information previously
recorded.

Additionally, if invoices relating to job billing are entered in the Accounts
Receivable module before the installation of Job Cost, reverse these invoices
using the Adjustment feature in Accounts Receivable Invoice Data Entry before
recording the job invoices. This prevents doubling the invoice information in the
Accounts Receivable module.

7 If work-in-process accounting is being used, the initial job billing entries
generate postings to the General Ledger module that adjust the appropriate
work-in-process accounts with the total accumulated costs for each job. You
must use General Journal Entry to back out these general ledger postings to
prevent double posting of information previously recorded.

8 Print the Work in Process Report for all jobs, and check the cost code, cost
type, and job-to-date information printed. Print the Job Billing History Report to
check the billing and cash receipt transactions. If any errors are found, use Job
Posting Entry or Job Billing Data Entry to make corrections.

9 Perform full period-end processing to clear the period-to-date information
affected by the conversion data.

10 Reset the accounting date to the first day of the current accounting period.

11 Enter cost and billing transactions for the current accounting period.
Transactions can be entered directly in the Job Cost module by integration with
other modules.

12 In Job Cost Options, select the Post to G/L for Direct Cost Transactions and
Post to G/L for Billing & Cash Receipt Transactions check boxes. This allows all
future transactions to post to the general ledger.

You are ready to begin using your Job Cost module.
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Material Requirements Planning

Before using the Material Requirements Planning module, have a list of available
warehouses ready for use, and know whether each warehouse is a standard
distribution/manufacturing warehouse or a distribution warehouse that will receive
only transferred goods. This information will be used to define warehouse groups in
Warehouse Group Maintenance.

Payroll

Data You Need

Before using the Payroll module, have the following information assembled and
available for use:

e Your General Ledger Chart of Accounts
e Alist of the earnings and deductions used for payroll processing

e Employer federal, state, and local tax ID numbers for each tax jurisdiction in
which your employees are paid

e Any company-specific tax rates, such as federal and state unemployment
insurance tax rates.

e Alist of employees, complete with personal information and quarter-to-date and
year-to-date earnings and deduction history

To obtain correct information from your Payroll module, you must first bring it up to
date with your existing payroll system.

In compliance with federal and state tax reporting requirements, payroll systems
operate on a calendar-year basis. As the year progresses, large quantities of
quarter-to-date and year-to-date data are accumulated; therefore, the ideal time to
convert from your existing payroll system to the Payroll module is on January 1. If
this is not possible for your company, guidelines for installing the Payroll module at
different times during the year follow.

Converting at the Beginning of the Calendar Year

If you are installing the Payroll module at the beginning of the calendar year, enter
your information into the module; however, make no entries at any quarter-to-date or
year-to-date fields. These fields are maintained automatically as payroll is
processed throughout the year. With these tasks completed, you can proceed
directly to the year's first payroll cycle.

Converting in the Middle of the Calendar Year

To obtain correct year-end totals and proper tax calculations from your Payroll
module, you must first bring it up to date with your current payroll totals, including
quarter-to-date and year-to-date earnings and a record of accrued time-off hours.
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Payroll Setup Wizard

The wizard provides several pages of questions and options that aid you in quickly
setting up the Purchase Order module for new companies. You must run the wizard
before completing any other tasks in the module.

To run the wizard, select Payroll > Setup > Payroll Options. If the company has not
been set up, a message asks if you want to set up the module. Click Yes to start the
wizard.

To record year-to-date information

1

2

Enter all employee information into the system.

In Company Tax Group Setup, select the Federal tax group. On the Tax Rates
tab, in the Tax field, select Federal Unemployment Tax Employer Liability. Enter
the effective date and your company's tax rate (if applicable).

In Company Tax Group Setup, select each applicable state and local tax group.
On the Tax Rates tab, in the Tax field, select the applicable tax, and then enter
the effective date and your company's tax rate (if applicable).

In Payroll Options, in the Current Quarter field, select the previous quarter.

In Payroll Options, in the Integrate With section, clear the General Ledger
check box. This ensures that no general ledger postings are made from the
Payroll module. Because the prior quarter information should already be
reflected in your general ledger balances, allowing the postings to update would
result in duplicate postings.

If you are using the Bank Reconciliation module, clear the Bank Reconciliation
check box also.

Enter manual checks using Payroll Data Entry for each employee to record the
year-to-date earnings and tax information. In the Pay Cycle window, verify the
Manual Taxes check box is selected and the Print Checks check box is cleared.
You can use the previous quarter number as the check number. Enter all
earnings, deductions, and tax information using the year-to-date information
from the end of the previous quarter.

If an employee has worked in more than one state, make sure the earnings
information is entered separately for each state.

Print the Payroll Data Entry Audit Report and verify all information. If necessary,
make any corrections using Payroll Data Entry.

Print the Employer's Expense Summary to ensure that employer taxes and
Workers’ Compensation are calculated as expected. Verify that deposit liability
amounts match to what you have paid year-to-date as of the end of the previous
quarter.

Print the Check Register and perform the Check Register update.
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In Period End Processing, select Quarter End Processing and print the
period-end reports. Verify that the information is correct and make corrections if
needed.

The Current Quarter field in Payroll Options increments to the current quarter.

If you are converting your payroll at the beginning of the current quarter,
proceed to step 5 in the procedure below.

If you are converting in the middle of the quarter, you must record each check
issued during the current quarter using the following procedure.

To record current quarter checks

1

Enter each check issued during the current quarter as a manual check in
Payroll Data Entry (that is, in the Pay Cycle window, clear the Print Checks
check box and select the Manual Taxes check box). Enter the earnings,
deductions, and tax information exactly as written on the original checks.

You can enter a combined total of the checks issued for each employee. This
method, however, does not provide the full detail and complete audit trail
facilitated by a detailed entry of each check.

Print the Payroll Data Entry Audit Report and verify the accuracy of all entries. If
necessary, make any corrections using Payroll Data Entry and reprint the
Payroll Data Entry Audit Report.

Print the Employer's Expense Summary report to ensure that employer taxes
and Workers’ Compensation are calculated as expected and that deposit
liability amounts match what you have paid.

Print the Check Register and perform the Check Register update.

Print the Quarterly Tax Report and the Payroll Check History Report, and verify
that all employee information and tax rates are correct.

Print and verify the Time Off Register. If adjustments are necessary, access
individual employee records in Employee Maintenance.

In Payroll Options, select the General Ledger check box. This allows all future
payroll processing to post to the general ledger.

If you are using the Bank Reconciliation module, select the Bank Reconciliation
check box.

You are ready to begin using the Payroll module.
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Purchase Order

Purchase Order Setup Wizard

The Purchase Order module includes a Purchase Order Setup Wizard that you must
perform to convert your existing companies and account structure.

The Purchase Order Setup Wizard provides several pages of questions and options
that aid you in quickly setting up the Purchase Order module for new companies;
you must complete this wizard and the Conversion Process on page 106 before
using the Purchase Order module.

Data You Need

e Before using the Purchase Order Setup Wizard, have the following information
available for use:

e Your General Ledger Chart of Accounts

e Alist of vendor quantity discount rates you use for inventory items
e Alist of all addresses to which you have orders shipped

e All open purchase orders and back orders

e All receipts, invoices, returns, and material requisitions as of your last closed
accounting period

To obtain correct information from your Purchase Order module, you must first bring
it up to date with your existing purchase order system.

Conversion Process

Complete the following process to ensure that your current accounting system is in
balance. These steps should be performed after completing the setup wizard.

To convert your existing purchase order system
1  Gather all open purchase orders as of your last closed accounting period.
2 Prepare an adding machine tape totaling the orders.

3 Use Purchase Order Entry to enter the orders into the system. In Default Values
for Purchase Order Entry, clear the Print Purchase Orders check box to prevent
the conversion orders from being reprinted. Next, on the Purchase Order Entry
Header tab, select Standard Order in the Order Type field and Open in the
Order Status field for each order.
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Partially received or invoiced purchase orders cannot be processed using the
system without double posting to the General Ledger and Inventory
Management modules. These orders should be processed manually until they
are completed. To enter these orders, you must enter only the unreceived
balance on each order as the original order quantity. There are no such
restrictions for outstanding orders that have not received any partial receipts or
invoices against them.

Print the detail version of the Open Purchase Order Report for all order types
and orders with an open status. The total on this report should equal the total on
the adding machine tape you prepared in step 2. If the totals do not agree,
return to Purchase Order Entry and make any necessary corrections and reprint
the report as an audit record of your outstanding orders.

Record all receipts, invoices, returns, and material requisitions that you have
received since the last closed accounting period to bring the system completely
up to date.

You are ready to begin using your Purchase Order module.

Sales Order

Sales Order Setup Wizard

The Sales Order module includes a Sales Order Setup Wizard that you must
perform to convert your existing companies and account structure.

The Sales Order Setup Wizard provides several pages of questions and options that
aid you in quickly setting up the Sales Order module for new companies. You must
complete this wizard and the Conversion Process on page 108 before using the
Sales Order module to process your daily transactions.

Data You Need

Before using the Sales Order Setup Wizard, have the following information
assembled and available for use:

Your General Ledger Chart of Accounts
A list of standard miscellaneous charges and items used in your business

A list of item part numbers sold by your business (if the Inventory Management
module is not integrated with Sales Order)

A list of your shipping rates
All open orders and back orders
A Customer Listing from your Accounts Receivable module

An Inventory Item Listing from your Inventory Management module
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To obtain correct information from your Sales Order module, you must first bring it up
to date with your existing order processing system.

Conversion Process

Complete the following process to ensure that your current accounting system is in
balance. These steps should be performed after completing the setup wizard. First,
enter any unpaid invoices, as of your last closed accounting period, into the Open
Invoice file. This process is performed using the Accounts Receivable module.
Second, use the Sales Order module to enter any open orders or back orders into
the system.

To convert your existing sales order system
1 Identify all open orders as of your last closed accounting period.
2 Prepare an adding machine tape totaling the orders.

3 Using Sales Order Entry, enter these orders into the system. Use the standard
order type for standard sales orders, and the open order status for open orders.
When entering the Sales Order Entry default values, clear the Print Sales
Orders and Print Pick Sheets check boxes, and enter 00 in the No. of Ship
Labels field in the Default Values for Sales Order Entry dialog box to prevent
these documents from being printed.

4 Identify all open back orders as of your last closed accounting period.
5 Prepare an adding machine tape totaling the back orders.

6 Using Sales Order Entry, enter these back orders into the system. Use the
back-order order type for back orders, and the open order status for open
orders.

7  Print the detail version of the Open Sales Order Report for all order types and
the open order status. The Open Order and Open Back Order totals shown on
this report should equal the totals on the adding machine tapes prepared in
steps 2 and 5. If the totals do not agree, check your adding machine tapes and
the Open Sales Order Report. Return to Sales Order Entry and make any
necessary corrections, and then reprint the report as an audit record of your
outstanding orders.

You are ready to begin using the Sales Order module.
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Data You Need

Before using the Work Order module, have the following information assembled and
available for use:

e Your General Ledger Chart of Accounts

e Alist of work center locations, including the number of employees and number of
standard hours available per week at each location

e Alist of operations to be performed, including cost and overhead calculations
and general ledger production cost accounts

e Alist of employees (optional), including labor rates and social security numbers
e Alist of labor crews (optional), including the employees in each crew

e A calendar of days when the entire shop is closed

e A calendar for each work center with exceptions to the shop calendar

e Alist of tools to be used during operations (optional)

To obtain correct information from your Work Order module, you must first bring it up
to date with your existing work order system.

Because the Inventory Management module is integrated with Work Order, it may be
impractical to bring the system up to date and reconstruct the original material cost
information that should have been recorded. If you have installed the Inventory
Management module, it is difficult to record past material issue transactions for work
orders without affecting the current inventory balances.

The easiest and most effective way to convert the Work Order module is to enter
only new work orders into the system. Do not record any transactions related to
preexisting work orders using the Work Order module. You can use the Inventory
Management module or the Bill of Materials module to record issues and receipts
related to these work orders. For labor and miscellaneous expenses, the general
ledger can be adjusted directly using General Ledger General Journal Entry. If the
duration of your work orders is short, you can quickly complete the conversion
process after all of the preexisting work orders are completed.
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Conversion Process

Complete the following process to ensure that your current accounting system is in
balance.

To convert your existing work order system

1

In Work Order Options, clear the General Ledger check box to prevent any
postings being made to the general ledger while entering conversion
information.

Enter all open work orders using Work Order Entry.

Enter all transactions recorded for open work orders using Work Order
Transaction Entry. Material costs may not be the same as the original costs.

Print the Work Order Transaction Journal, and perform the update.

Print the Open Work Order Report to verify the information recorded. If
adjustments are necessary, repeat steps 3 and 4.

Print the Work in Process Recap report to verify the information recorded and to
reconcile to the general ledger.

If you are entering material transactions for existing work orders, you can freeze
inventory and perform a physical count and physical count entry without
updating. Updating the Physical Count Variance Register should be performed
only after all material issue transactions are recorded for existing work orders.
Adjustments made during the Physical Count Variance Register update are
recorded as physical adjustments in the Inventory Management Detail
Transaction file. The Inventory Adjustment account in each item's product line is
used to offset the Inventory account posting, unless the General Ledger check
box is cleared in Inventory Management Options during the update process.

Perform the physical inventory process to update the quantity-on-hand
information in inventory. This step should be performed after all material issue
transactions have been recorded for open work orders.

You are ready to begin using your Work Order module.
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